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SKYDOME TECHNICAL CHARACTERISTICS

Radius Concrete
span > mption
(mm) ) ) Slab
thickness | thickness
50 mm

120 | 158 | 188 | 10 | 700 820 0.080 0.130 0180 | 0230

Skydome H200 160 | 193 | 237 | 40 | 700 B6D 0.091 0.141 0191 | 024

200 | 233 | 279 | 140 | 700 900 0100 0.150 0200 | 0.250

120 | 170 | 213 | 140 | voo B20 0.099 0.149 0193 | 0249

Skydome H250 160 | 210 | 254 | 140 | 70O B6O 0.113 0.163 0213 | 0263

200 | 250 | 285 | 40 | 700 900 0.125 0.175 0225 | 0275

120 | 205 | 267 | 140 | 700 | 20 0123 0173 | o0zz3 | o273

Skydome H300 160 | 245 | 308 | 40 | 70O B6D 0.139 0.189 0233 | 0.289

200 | 285 | 350 | 140 | 700 900 0.153 0.203 0253 | 0.303

120 | 263 | 302 | 140 | 700 820 0.151 0.201 0231 | 030

Skydome H350 160 | 303 | 32 | 140 | voo 86D 0.169 0.219 0268 | 0319

200 | 343 | 384 | 140 | 700 800 0.185 D.235 0285 | 0335

120 | a8 | a7 | 40 | 700 820 0.185 0.235 0285 | 0335

Skydome H400 160 | 388 | 388 | 140 | voo 860 0205 0.255 0305 | 0355

200 | 428 | 430 | 140 | 700 900 0222 0.272 0322 | 0372

Max. slab’ | Beam width [ Skydome Siab | Total siab Self Live Steel section, | No.ofbars | Steel Wire mesh
span (m) L1 (mm) depth thickness | thickness weight load ribbing and diameter | section, slab]  characteristics
{mm) H1 (mm) H2 (mm) kgfm?® kg/m? {cm?) (cm?)

5.00 120 200 50 250 325 400 2.26 2dn12 2.01 DN8/200X200
6.00 160 200 50 250 353 400 2.26 2dn12 2.01 | DN8/200X200
6.00 160 250 50 300 408 400 3.08 2dn14 2.01 DN8/200X200
6.50 160 250 50 300 408 400 3.08 2dn14 2.01 DN8/200X200

(SKYDOME ProductSheet) Jélg slo &gl (BuicSudsi Jolis diges & JSis

Sl oas ools HLas VS 10 aS 5 1o 092 g Seb ol (gl (gl e o lasliwl sl 5 sasie VLI jo pl 1 0gdle

8, 10, 12, 14, 16 for 19-in. domes

12
8, 10, 12, 14, 18, 20 for 24-in. domes
[l
-[ 8, 10, 12, 14, 18, 20 for 30-in. domes
2¥%'1) 19 G 18-in. domes
) 24
3'1 24 3 24-in. domes
30
3'17 30 A3 30-in. domes
36
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Table of stiffness assumptions for modeling concrete structures.

Property Modifier for
ACI 31811 LATESDC NZS 3101; Part
Elements 104041 | pgcp 4q.q3| PEERTBI | MCE-Lovel [LATESDE | 0 oo [NZS 3101: Part 2:2008 42006 Paulay & [ogeany cania
Tkt 10.5 | Guidslines. | Non Linar | SOREARAHY | EENESEE ['Ubimato Limit Stata | Servicability Limit | C$A A23.3-14| EuroCoda | T5500-2000 | Prlestioy [0Sste EHW L
ACI 318 orvice | - Modols R {y=300Mpa) = (1992) Ky
86341 Lovel (2014) Nota 3)
0701z
0.401g (rectangular)
Conventional Beams (LH>4) |  0.35Ig 0.301g 0.50g 0.35lg 0.701g. 0.500g. O.]glg (TandL | ‘;gf"”%‘"‘QL 040lg | 0.171g-0.441g
beams) g (T an
Baams 03slg | 0.50g 0.401g
Presressed Beams (LH » 4) 1.00Ig L00Ig na nfa 1.001g na nfa na na
na
0.601g (diagonall
Coupling Beams (LH s 4) nfa nia 0201g 0301g na m%n(f;;’f:,‘;a ¥ 0.751g 9y nfa
Columns - Pu 0.5A
olumns - Pu z 0.5AgTe o015 7015 aolg 0701z 0.801g 100lg o 8015 0vote &) —C-20LE
Columns - Pu s 0.3Agfe 0.501g 0.551g 0801 0.60lg
Columns o Pr01AdT 0.701g o501 o o0l 070lg | 0.50lg ool 0.121g-0.861g
olumns - Pu £ 0.1AgT E X
0.301g na wa ¢ £ £ £ ©
Columns - tension na na nfa nfa
Walls - unerackad 0.701g na nfa na 0.801g wa na 0.7lg 0.501g na na
0751z ©)
Walls 0.401g - 0.801g
) Wals - cracked 03slg | 0.501g 1.00Ec(1) | 0.75lg 0.501g 0321g-0.481g 0.501g-0.701g o3slg | osorg (MRS 0201g-0.30lg
Walls - shear na  [040Echw (1 nia 0350Ag | 1.00Ag na na na nia nia na ©) na
‘Conventional fia plates and fi
onventional s..LS tesandflat) 3515 |see 104.4.2 nfa (©)
0.50lg 023lg 0.50lg n/a na na 02slg | 0.50g na
Slabs Post tansionied fat plates and nfa  [See 10442 nfa na
In-plane Shear nfa na na 025Ag | 080Ag nfa nfa nfa nfa nia nfa na na
Notos. 5 @ @ @ 3) m
Notas Dafinitions:
(1) Non-inear fiber elements automatically account for cracking of concrete because the concrete fibers have zero tension stifiness. Ig = Gross moment of inertia
(2) Elastic modulus may be computed using expected material strengths. L = Clear span of coupling beam
(3) s ductiity capacity. H = Height of coupling beam
(4) Wall stifiness is intended for in-plane wall behavior. Pu = Faclored aial load
(5) ACI 318-11 Seclion B.8 (ACI 318-14, Section 6.5) permits th ption of 0.501g for all elements factored lateral load analysis; Ag = Ac = Gross (uncracked) area
(6) TS 500-2000 specifies the use of 0.41g for PuAS/FC < 0.1 and the use of 0.81g for PwAcTc > 0.4; interpalate for all values in between 0.1 and 0.4. fc = Compressive strength of concrete
(7) T and L beams should use recommended values of 0.35 [g. For columns, categaries are P=0.2fc Ag and P =-0.05fc Ag Ec = Modulus of elasticity of concrete
(8) Shear stifmess properties are unmodified unless specifically noled otherwise. fy = Yield stress of reinforcing steel
(9) Effective siifiness per equation. See reference for more information. MPa = Megapascals
(10) Notz that G = 0.4°1, 30 ASCE 41-13 is recommending that a madifier of 1.0 be used for the shear stiffness of concrete shear walls; that is, they recommmend no reduction in shear stiffness. Aw = Horizontal area
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Axis 2

Axis 2 /' \\M—MAX
/@ . @
R &

Axis 1

Forces are per unit

of in-plane length Moments are per unit

of in-plane length Axis 1

Transverse Shear (not shown I
Positive transverse shear forces and

stresses acting on positive faces
point toward the viewer

i j2
STRESSES AND MEMBRANE FORCES i

Stress Sij Has Same Definition as Force Fij PLATE BENDING AND TWISTING MOMENTS
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Exterior column Interior colurnn
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Basic control perimeter
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=12d,
/\;"n
=2d
45° max.
Z 6d, 7&/,, 6d, S
(a) Single-leg stirrup. (b) Multiple-leg stirrup.
(c) Closed stirrups.
Critical section
through slab o 2
shear reinforcement ERag Caical mm
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(d) Stirrup layout showing inner and outer critical shear perimeters.
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Table 22.6.5.2—v. for two-way members without
shear reinforcement

Ve
0334/ @
0.33
17 +—— (A A S
Least of (a), (b), and (c): (0 17+ B } s JZ (b)

0.083a,d -
[O'IHTJMWE ©)

Notes:
(1) A, 1s the size effect factor given in 22.5.5.1.3.

(1) B 15 the ratio of long to short sides of the column, concentrated load, or reaction
area.

(111) o, 15 given n 22.6.5.3.
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Edge of srab7
e

{b} Critical perimeters if A and B do not excesd Lhe greater of 47 or 24y,

Edge of slab Z

-
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(c) Critical perimeters if A exceeds the greater of 4f or 26, but 8 does naot.
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_ (# of ribs within the drop panel width)x /1 xb,
the drop panel width

d

— ] |~a— by

2y il 5l gy 4l o d lade (3,0 Y SIS
1] (oo Cewy o abal) 5l e Cunl Jolae (LB 52 by oS
b,=b+d/12
Al (g0 4z 2)e D g az s sloo Sl s 3550 b (6,Lad )6 0 5590 alols 0 (3gd alal, 5o
s g5l ] jloslicwl baci Golko of 4ifio iy lawlro Lig,
D9 oo dumle Uy , Ve polie ) SVolee 5l oolitnl b eygiw 51 A/2 alols 4 Jloo ahaio 0 -
W | YorMuxy | YoyMuyx

vy =—+
tA Jx Jy

Table 22.6.5.2—v for two-way members without
shear reinforcement

Ve
0.33A 77 @
0.33 3
Least of (a), (b), and (c): [0-17+T]1‘1JZ ®)

0.083a,d -
(0.17+ b JMLJ,? ©)

Notes:
(1) A, 1s the size effect factor given in 22.5.5.1.3.

(u1) B 1s the ratio of long to short sides of the column, concentrated load, or reaction
area.

(111) o, 1s given in 22.6.5.3.
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I, - e 3

2 350~ h,
Tension lap T e [wo_( 3 )mm}

splice restricted - 24in (100 mm)

to center half of ' £6in (150 mm)

member length —— Along I, transverse reinforcement
spacing <5, and quantity

satisfies full confinement
requirements as identified in
Table12.2

Provide full height if
supporting discontinued stiff
member,

1 Maximum cover=4in (100 mm)
[ + unless additional transverse

1 reinforcement is provided

with cover < 4in (100 mm)
ats=12in (300 mm)
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Table 7.3.1.1—Minimum thickness of solid
nonprestressed one-way slabs

Support condition Minimum Al!l
Simply supported £/20
One end continuous £/24
Both ends continuous €128
Cantilever £/10

[UExpression applicable for normalweight concrete and f, = 420 MPa. For other
cases, minimum / shall be modified in accordance with 7.3.1.1.1 through 7.3.1.1.3,
as appropriate.

)0 J.:La Js» )JJLQ.A o}!p rb-'-L-H-' 6[& wu.a )-)LA-AJ 6‘,» Sl 00 w...la..u fy=420 MPa L.S‘)" sl U""—‘ A Jsd?
Sheed L ogd gy e J L plejed a5 G900 j0 (55l Cuoles 0958l (Sl 09 o yo 0.4+ 700/fy

s ol ,8 ol i aBlae BlasT 4y )8 50 4S5l 0emg ail anils T L S e 5L,
Ao g, V=V=Y-A o j0 - o b ol css s Hlas 0,90 Jlo aSol as a4 ybogd gledld 050 10 asl ]

09 i ad ybgd gldlo 5,50 y0 el 00,5 il e - Jlo gl Y-V-Y-A a5 cou sl sl p culs JBlos
39 [l S g Al polie 9 V-V-Y-A Jgoo polie jlasls s (5 culs do o 4SS o J I sle s

o e VYO  Drop panel 50 slls .l

o Jue Voo Drop Panel l)ls sldls .o

Table 8.3.1.1—Minimum thickness of nonprestressed two-way slabs without interior beams (mm)!!

Without drop panels!*! With drop panels!
Exterior panels Exterior panels
fi» MPall | Without edge beams | With edge beams!] Interior panels Without edge beams | With edge beams"! Interior panels
230 £33 £,/36 £,/36 £,/36 £,/40 £,/40
420 £/30 £33 £33 £33 £,/36 /36
550 £27 £,/30 £,30 £./30 £a/33 £n/33

[y, is the clear span in the long direction, measured face-to-face of supports (mm).

FlFor f between the values given in the table, minmmum thickness shall be calculated by linear interpolation.

BIDrop panels as givenin 8 24

18 1abs with beams between columns along exterior edges. Exterior panels shall be considered to be without edge beams if ayis less than 0.8.
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Table 8.3.1.2—Minimum thickness of
nonprestressed two-way slabs with beams
spanning between supports on all sides

g, M Minimum /1, mm
g, = 0.2 8.3.1.1 applies (a)
£, 0.8+ -—-'ﬁ .
02 <a. <20 Greater 1400 (b)HHA
o i = 2 of 36+ 5P(ae, —0.2)
125 (c)
£, 0.8+ L
0 =70 Greater 1400 (d)
e of: 36+9B
90 (e)

My, 15 the average value of oy for all beams on edges of a panel.
Py, is the clear span in the long direction, measured face-to-face of beams (mm).
IR is the ratio of clear spans in long to short directions of slab.
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Table 24.2.2—Maximum permissible calculated deflections

Deflection
Member Condition Deflection to be considered limitation
Flat roofs | Not supporting or attached to nonstructural elements likely to Immediate deflection due to maximum of Z,, S, and R £/18001
be damaged by large deflections
Floors Immediate deflection due to L €360
Likely to be daIr{aged by That part of the total deflection occurring after attachment 21480031
Roof or Supporting or attached to large defiections of nonstructural elements, which is the sum of the time-
floors nonstructural elements Not likely to be damaged dependent deflection due to all sustained loads and the .
by large deflections immediate deflection due to any additional live load™ £/240
HLimit not intended to d against ponding. Ponding shall be checked by calculations of deflection, including added deflections due to ponded water, and considering time-

dependent effects of sustained loads, camber, construction tolerances, and reliability of provisions for drainage.

D Time-dependent deflection shall be calculated in accordance with 24.2.4, but shall be permitted to be reduced by amount of deflection calculated to occur before attachment of
nonstructural elements. This amount shall be calculated on basis of accepted engineering data relating to time-deflection characteristics of members similar to those being considered.

BILimit shall be permitted to be exceeded if measures are taken to prevent damage to supported or attached elements.

FILimit shall not exceed tolerance provided for nonstructural elements.
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Table 24.2.4.1.3—Time-dependent factor for
sustained loads

Sustained load duration, months Time-dependent factor §
3 1.0
] 12
12 1.4
60 or more 2.0

[Branson, 1976] el suis al)l 55 Sle; slash ple Gl loges & g0 4 yial)b o
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Months ! Years

Duration of load
E loj & ks ;5356 YA JS
il 08,5 slpaion 1) 5 ole Baile ol 5l ab sle IS s 6l Y-Y-YF Jgus
oloj o aioly slo [5G, ii faazo b Ceol ol a5 o) 05l il (slin] Jlai] ] ey oul ol ] 56 ki I o
olli; L;Lojéj/w;}b@'/'g& MK i g B Wile ol L
05 g0 dawloeo 1) =F=T=FF aba), j/oolicn] b loj 40 diwnly (glo JSCopecti aS Col 005 Lo 4l u-*-’] ol pegdle
.M,o.fd/’j//jcg/o)'bﬁé slael Jlail ;] fS slo S pess Cunl jlxo #lib 4
R PP b PR ARG PRV SR O JUUES S OO CSNp ST ORI =1 YOS PRSI g e JUi

A= Apoolip + ABips +4A;;

40
obe sagellae



oo (rwiige sl By Gldls (b sleial,

e 358 Dl S Al 33 358 (o b (59555 55 b o6l b 558 alafy sl U5 1S

b sl ojbo pue sliael JLasl 5l 8 00,0 )l 51 (o800 St & el JBaile (slajl oo atncly sl S i
(o)l 51 (o3 T IS i Ay g, t03,50 (L), 51 86 ST Syt A p sl 00 05 Agg o0 oy 51 0lici
G5 4 ais 0aiy gla b 5l ke Cand ol o 0 ()b B ale s 5 iU ST IS s Ajp 6 g 0055

d.olJ u...v—|) 03.....1 <° QLQH..H.' ‘59&»..;: ul.o.._’>L..u 6‘,} DJJ)' le.b)l.u k}SM)O Y& la).:‘).) YBAM ‘;5 Cond u5Lﬂ.~od5

o alal) aylie Bl 0035 005 (sl b Connd | LU S yas (unsl 43I b oage 4y |y Sluio ool i
a5l o o3 slasb ST S5

AiL = Bio250+p —Aip
Lagp & Jaie slee i b Jlo 0 olog sl & o ololyy a5 V2 -F-Y-YF alad, A ke b el s A oo
U"L“‘)) )")’]‘-‘/100 )L}.a.n AJT < Cowdy (JS 6‘;}‘ )‘ o= olo Mysm) J.:s.w < u..a.: [ &J“"""Q)L' as tO ULQ) L

(el 2315 (59, Bl 0aiy slo,b 5 b JSCi pas pled ol i (2,8 1133) 99 o0 dmle & = 2
ol 03 il sl g Sl g, 4 dzgi b ogd oo duglio Y-Y-YF Jouz jloe jlade b A i awlxe 51 uy
A< 1/480

* 5 s l & - & - -
3,90 ailas j9mme du ygome alold | (595 oo Slgioy 500 wlo Flas boad ezl slo i )b sl g Jos j0) ail
P8 510 b el o sk B S sl S Sy bt S s ol ol B il on (55 o)
WS oo oolaiwl 398 alaily S 6l BL
[
AL'LS_ 5l:\/a2+b2
' 360
(Cwl oy dnogs Jhad Jab) ol S zl,b Jlai 4y 398 Lailg, 5l plaS™ a5l ool
WF iy Gl pae Do 50 il 0550 50 45 05 azgi b Sael Gy g o SIL o 5 jlme ke S plSe

0 @l ,gulS b abaii b o)l (S5 95w 8T Job [ jpans] )3 ail o (55500 Allaz Sjg0 4 oy

sk

SAFE aoliys ,0 15 dewlxs
&

@S syl J S - O-F

s oz At [ S gz ge )l 1 g Ly (s sl ojle (139 5 (B o 4 G Dj90 4 b
logas ol o plnl (b al> o eI L alaly )5 (cols J S o las Sl b Ll je o)l )0 52 5 axtudls
5ol gl wles 4o Jb ol b ooil 08,8 alll ) b oaisSTaz o cols laol 5l oolitas] cs barlsds o5 el )30 o
@l G5 55 ol pogdle 09, Jled 4 (Sheal b alies Sy, Slate 51 Blas )| Cesl (S (0 S (sl i

S I D908 eee (nl 4 4295 Cenl (Soe 09d (g ool (L5559 5005 sln S

41
obe sagellae



oo (rwiige sl By Gldls (b sleial,

AISC Design ATC 1.0 4 olsi o e ol 51 45 ol 00 e o S gloil alas | bl sl coblizee ol i
38 ol )| S 095 5950 4 ATC gy o9 5 ool db axg5 b bl jo 20,5 oLl CEN TC 250 L, Guide 11
lS 5 Slasl sl o] ol ko 05 oo auSTh Ioazme il paly Lasaly ol 5l oslitul L ity (sla wiS

@ gadlhel; basie Sl S8 a4 wb ojlse (nl )3 glib g Cnl Glohg Ak alie Sl 4 les slo

sled dazl o abogs o (gloo sl

JAS g,y Bl (oo Ji 0590 33 (sla pl5 WS 53 5l (AL Bl )| i & SoSae sla s 25 j0 00le ok 4

Jsuzu)lwwij%w,wtﬁpwfwyuwbu-

IR ﬁ‘)‘;ﬂw‘_;lb 6)'.’)[5&5‘):’ ‘J},_e JJb)JQLM)).A)J))‘QjN)OASL;)JBJU )bcafol.n.ol)wg_:u MLD.Q—

10.0
Rhythmlc activities,
\ outdoor footbridges
5.00
3.00

shopping malls,
dining and dancing

1.50

1.00 Offlces, residences,

churches

vd

Vi
/ Indoor footbridges,
/ ’

V4

0.50 / "
Operating rooms

NN NN

025

Peak Acceleration (% gravity)

/A 150 Basel
0.10 aseline curve
/ of RMS acceleration
/ for human reaction

0.05

1 2 4 8 12 20
Frequency (Hz)

6275 sle yrolin b ainis G anylio ¥4 S
Qw‘scwl}u»))) 4da.:‘) )l 9y eoLuL:Ja..J)AWUL.w

ap Poe_O'San
g BW

ool T s Su03 b fir b Sblie (59, 00y Siisa)le g9y Poe 03 o e
el 55, 00l aasin Culi g9, Py

035 (on e 133 o3 5l oslizul b 45 Conl GS o5l ks iS5 fy

ool Jloga oo G 8

9 S ojle Sge e W

42
obe sagellae



oo (rwiige sl By Gldls (b sleial,

loaslg il oo (63, 00ks 5l (8L QoS 0ds0y 4 Cand LS Cangliie legome W 0l oo adl> &5 Ot 55 g

ap :
29 0l Jl3g05 3~ Ll 1 45 (alole 228l oo ID — Im

95l o 2505 4 B 5 Po eyl sl o o olas

B ol o Py, lb ool 50 s
o 05 =0_ o) £0 e 51 (5,015 g bl ds il ol
.Y £0 292 55150
) ay (510 ool le gla ol5 58
N Q¥ (2)1) ooly ple sl 05,38

AJ,ij)A YA @Z@')JB&L?U[? g}’bj Sl AS.M.) ‘_gL(b W)L: l.: 6)10‘ )5|)A 6‘).3 A .»))lé e).,)lf Sl 00
el 05 o] il £l oo o iyl 45 el il Lt

Onl dloe 1o 1581 0 3 SUlg 4 g8 b aS 0,00 0929 a5 Loled )] (sl el )l dlone (5l Al Lals) g b g,
el ot o5 T & Ll o (W 5 fiy ) Loyl

ans 3l JB zolaw lp o S ol 508 gl sl oole by, o0 VYRR ilng) plessle e &) yie g Cone
W55l s a5 b el 08,5 ] (aisles o (3l 5 e lyic d ol sSme a5 5 polic Lo L) i b Aiae (g
& 0 9 o g i od o0 by 3l ool asis i 5 (st 45 (S g slo plozslo 5]
S5 18 eolatul 890 Hlimed w9, SO Glare 4 Wil oo 015 Sggn o

CSAFE asl s 5l ool L W g fiy 5l | gl ol dnslons 4y b @

Sy Cwds Slisdo ple —F-F

Llps Jb nl b cl 00,8 @byl (g55m G251l 50 6l QU sy (slgd (o Ol e o oo (g g i/ Al

b Lo o dase 0)lge g Canl By ol 50 Lo SO o dy b Gl 50 oo sl il 5l (S Lo o5l Jo 5
gy 5,15 Ebs0 9 el & aranl 3 ilis Slaasals g 1 il w05 536 pllas Ly oS (s lone
Gzl 0,90 yo sl onls )l o g s sl plasle Gl sl 6)5] b oyl goumie ol ACI 216
izl s G Ol 5 i 9y90 257 Sl Gl ol Sl Jlesl b i g9l U (s slo o3l Jsone

9d (o8 el

Paperless °

43
obe sagellae



oo (rwiige sl By Gldls (b sleial,

)._>|).3 ) 6)9T ul.’ Celw T LY el ’D)y L.OSGLQJ‘»)} émwf)b)&bf)b Lng)‘yo J‘d Caalns JS‘»—\—;.OJ‘

0dds Hlo s (pl V- gz 50 e alaSin iz 4 diiws l ojle o Ll cpl Celes JBlas ansl asils u...fl

o

Table 2.1—Fire resistance of single-layer concrete
walls, floors, and roofs

Aggregate Minimum equivalent thickness for fire-resistance rating, in
Lype l hour  [1-1/2 howrs| 2 hours 3 hours 4 hours
Siliceaus 35 43 50 6.2 7.0
Carbonate 3z 4.0 4.6 57 6.6
. gﬁfj:@ht 27 33 318 46 54
Lightweight 25 3l 36 44 51
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Table 2.3—Minimum cover in concrete floors and

roof slabs
Cover | for carresponding fire resistance, in.
Aggresate Restrained Unrestrained
ype 4orless | 1 howr |1-172 hours| 2 hours | 3 hours | 4 hours
Nonprestressed
Siliceous 34 a4 4 l I-1/4 | 1-5/8
Carbonate 34 4 34 34 1-14 | 1-1/4
Sermi-
lightweight 34 a4 34 K2 I-1f4 | 1-1i4
Lightweight| 34 4 4 34 I-1/4 | 1-1/4
Prestressed
Siliceous 34 1-1/8 1-142 1-34 | 238 | 234
Carbonate 34 1 1-3/8 1-5/8 | 2-1/8 | 2-1M4
Semi-
lightweight 34 1 1-3/8 1-1/2 2 2-1/4
Lightweight| 3/ 1 1-3/8 1-1/2 2 2-14

s 59y 5l Gigy 09d (o0 DLl (g liee 5551 P S 9550 lies 5 i sl AlaSis g9 a Aty G byl o
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Table 2.4—Minimum cover in nonprestressed beams

Beam | Cover for comesponding fire-resistance rating, in.
width,
Restraint n. I hour | 1-142 hours | 2 howrs | 3 howrs | 4 hours
5 374 374 M 1 1-1/4
Restrained 7 34 34 34 34 34
=10 34 34 34 34 34
5 304 1 I-1/4 | NP* NP
Unrestrained 7 34 374 34 1-374 3
zl0 34 374 34 1 1-3/4

*Not permitied.
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Modeling slabs with variable thickness, loading and soil subgrade
modulus

Skip to end of metadata

Created by Truly Guzman, last modified by Mohamad Ali-Ahmad on Oct 07, 2019

Go to start of metadata

To model slabs with variable thickness and loading in SAFE, it is best to create a base slab which spans the entire floor, then draw slabs of
variable thickness over the base slab to adjust local geometry and loading. Contained-area slabs drawn over the base slab will take precedent. This
applies to every area object except drop-panels. To apply variable loading, assign NONE properties to contained-area slabs, then select Assign >
Load Data to specify load magnitude and direction. When assigning loads to NONE areas in both programs, loads will be added to the exiting
base slab.
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Item

ETABS

SAFE

Shell stiffness
(including any
stiffness modifiers)

The slab object with the smaller
area takes precedence.

If the slab objects have a
stiffness A and the drop panels
(assumed to have a smaller area)
have a stiffness B, then at the
drop panels, the stiffness is B.

“Drop” type slabs take the
highest precedence. If two slabs
are the same type, the slab
object with the smaller area
takes precedence.

If the slab objects have a
stiffness A and the drop panels
(regardless of size) have a
stiffness B, then at the drop
panels, the stiffness is B.

Area/Temperature
Loading

The slab object with the smaller
area takes precedence.

If the slab objects have a loading
A and the drop panels {assumed
to have a smaller area) have a
loading B, then at the drop
panels, the loading is B.

Loading values add together.

If the slab objects have a loading
A and the drop panels have a
loading B, then at the drop
panels, the loading is A+B.

Soil/Area Springs

The slab object with the smaller
area takes precedence.

If the slab objects have soil
spring stiffness A and the drop
panels (assumed to have a
smaller area) have soil spring
stiffness B, then at the drop
panels, the soil spring stiffness is
B.

The soil subgrade modulus with
the higher value will take
precedence.

If the slab objects have soil
subgrade with stiffness A and
the drop panels (regardless of
size) have soil spring stiffness B,
then at the drop panels, the soil
suhgrade stiffness will be the
highest of A and B.

Notes:

1- Shell rigid diaphragm must be explicitly assigned to null areas in ETABS for their loads/additional mass to be included in modal analysis
(seismic mass).

2- For semi-rigid diaphragms, the contained areas are recommended to be assigned with the same structural properties of the base slab in lieu of
null areas. The latter may cause local modes when their load/additional mass are part of the lateral mass source.
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Constrained
Joint

Autornatic
Master Joint

Constrained
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With the rigid diaphragm assumption, distribution of
lateral forces to the vertical elements was made based
on their relative stiffness. This assumption was
adopted in the first generation structural analysis
programs to reduce the computational demand on
memory and processor speed. The lateral forces
calculated for the vertical members at each line could
then be translated into shear forces to be distributed
along the diaphragm at each line.

In some cases, depending on the diaphragm material,
overall proportions, and relative stiffness of vertical
and horizontal elements, it was unclear whether to
assume flexible or rigid behavior. In such cases,
considering results from both flexible and rigid
analyses, designers often “enveloped” the analysis.

With currently available structural analysis software,
flexibility of the diaphragm can be modeled directly
wherever diaphragm flexibility is in question. Bounding
analyses is still valuable to understand the effects of
uncertain stiffnesses on design quantities.
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Bearing Wall Systems

Section 11.2 defines bearing wall systems (under the definition for “wall”)
as systems in which bearing walls support all or major parts of the vertical
load. Presumably, a major portion would be more than 50% of the total
vertical load. Bearing walls are defined as (1) a “metal or wood stud wall
that supports more than 1001b/linear ft of vertical load in addition to its
own weight,” or (2) a “concrete or masonry wall that supports more than
2001b/linear ft of vertical load in addition to its own weight.” Given this
definition, the likelithood is that most structural walls would be classified as
bearing walls.
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When slabs are supported on beams having ag£,/¢; = 1.0, the beams must be de-
signed for shear forces computed by assuming tributary areas bounded by 45° lines at the
corners of the panels and the centerlines of the panels, as is shown in Fig. 13-92. If the
beams have ay;€,/€ between 0 and 1.0, the shear forces computed from these tributary ar-
eas are multiplied by ay1€2/€1. In such a case, the remainder of the shear must be transmit-
ted to the column by shear in the slab. The ACI Code is silent on how this is to be done. The
most common interpretation involves using two-way shear in the slab between the beams
and one-way shear in the beams, as shown in Fig. 13-93. Frequently, problems are encoun-
tered when ag1€5/€; is less than 1.0, because the two-way shear perimeter is inadequate to
transfer the portion of the shear not transferred by the beams. Thus it is recommended to
select beam sizes such that ey €,/ exceeds 1.0 for a two-way slab.
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Coefficient of
Contact surface condition friction pM
Conerete placed monolithically 14 (a)
Concrete placed against hardened concrete
that is clean, free of laitance, and intentionally LOL ®)
roughened to a full amplitude of approximately ’
6 mm
Concrete placed against hardened concrete that
is clean, free of laitance, and not intentionally 0.6% ()
roughened
Concrete placed against as-rolled structural
steel that is clean, free of paint, and with shear o @
transferred across the contact surface by headed ’
studs or by welded deformed bars or wires.

), = 1.0 for normalweight concrete. For lightweight concrete, A is calculated as given
1 192 4, but shall not exceed 0 85.
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Condition Maximum V,
Normalweight concrete 021’4, (a)
placed mogohthlcnlly or Leastof| (33 +0.08£4, )
placed against hardened @), (b)
concrete intentionally y d ( ]
roughened to a full amplitude andie 114, (c)
of approximately 6 num
Lesser of 0.2f'4, (d)
Other cases (d) and
© 5.54, (e)
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4y Model Initialization *
Initialization Options
O Use Saved User Default Settings 0
() Use Sattings from a Model File... (]
(@ Use Buill-in Settings With:
Display Units | Metric S o | 0
Steel Section Database |AIsC14 v|
Steel Design Code | AISC 360-10 ~| @
Congrete Design Code |ACI 318-14 v | @
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[y Grid System Data s
Grid System Name Story Range Option Click to Modiy/Show
® oeout A e S
e O i St |
Top Story
Godx fo m St Options
Global Y o m Bottom Story Bubble Sz [1250 mm
Retation [ e [Base Grid Color _
Rectangular Grids
O Display Grid Data as Ordinates @ Display Grid Data as Spacing G|y Reference Planes
XGrid Data Y Grid Data
Giid ID X Spacing m} Visible Bubble Loc Grid ID ¥ Spacing {m) Vi Location of Reference Plane {Horizortal)
A 92 Yes End Add 4 3n e Z Ordndts Vbl 0
B Yes End 3 541 2 m
Delet
c ] Yes End 2z 332 Yo 157 es Add
1 Ya 430 Yes
T =
Yes
Sot
General Grids
Grd ID X1{m) Y1(m X2 m) ¥2(m) Visile
Delete
]
o N
|
[§ Ecit Story and Lnid System Lata A
Story Data
StoryS
Storyd
Storyd Modify/Show Story Data..
Story2
Story1
Base iy Story Data
Master Splice
Story Height Blevation Story Similar To Story Splice Height Story Color
m m m
Story5 33 1624 Yes None Mo 0 l
Grid Systems Storyd 325 1294 Na Story No 0
Story3 325 969 No Storyd Mo 1]
Story2 325 644 No Storyd No o
» Story1 319 No Story5 No 0
Base 015
Note: Right Click on Grid for Options
Refresh View
[ox ] [ cancer |
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¢4y Material Property Design Dats

Material Name and Type
Material Name

Material Type

Design Properties for Rebar Materials
Minimum Yield Strength, Fy
Minimum Tensile Strength, Fu
Expected Yield Strength, Fye
Expected Tensile Strength, Fue

[s300

| Rebar, Uniaxial

MPa

oK |

4y Material Property Design Data X

Material Name and Type

Material Name [san0

Material Type | Rebar, Uniaxial

Design Properties for Rebar Materials

Minimum Yieid Strength, Fy MPa

Minimum Tensile Strength, Fu MPa

Expected Yield Strength, Fye MPa
W

Expected Tensile Strength, Fue

oK | [ Caneel
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Dgl

tlly Frame Section Property Reinforcement Data

Design Type
@® P-M2-M3 Design (Column)
QO M3 Design Only (Beam)

Reinforcement Cortiguration Corfinemert Bars
@ Rectangular @ Tes
O Crodlar O Sprals

Longiudinal Bars
Clear Coverfor Confinement Bars
Number of Longtudinal Bars Along 3-ir Face
Number of Longtudinal Bars Along 2-dir Face
Longtudinal Bar Size and Area

Comer Bar Size and Area

Confinemert Bars
Corfinement Bar Size and Area
Longtudinal Spacing of Confinement Bars. (Nong 1-Adis)
Number of Confinement Bars in 3-dir

Number of Confinement Bars in 2-dir

Rebar Material
Longtudnal Bars

Corfinement Bars (Ties)

Y | P
[ |

Check/Design
O Reirforcement to be Checked

@) Reinforcement to be Designed

B Jm
—
C—

|20 Vll;“a” | mm2

[20 v||;_|\314 | mme

[10 ][] | mma

E—
E—
E—

iy Frame Section Property Reinforcement Data X

Design Type Rebar Material

O P-M2M3 Design (Column) Longtudinal Bars

T | P
e V0]

Reirforcement Area Overwrites for Ductile Beams

(@ M3 Design Orly (Beam) Corfinemert Bars (Ties)

Coverto Longtudinal Rebar Group Certroid

Bottom Bars at End
Bottom Bars at J-End
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£4y Wall Property Data

General Data
Property Name
Property Type
Wall Material
Notional Size Data
Modeling Type
Modffiers (Cumently Default)
Display Color

Property Notes

Property Data
Thickness

[z |

|Spectied 2

s ol

| Modfy/Show Notional Size... |

[ Shet-Thin v
| Modfy/Show... |
—
| Modfy/Show .. |

Er—

oK | | Cancel |
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4y Slab Property Data

General Data
Property Name |WaHle31}D ‘
Slab Material [cas [

Motional Size Data ‘

Modify/Show Notional Size

Modeling Type |5hel-'|'hin v ‘
Modifiers (Cumently Defautt) \ Modify/Show |
Propety Notes \ Modiy/Show.. |
Property Data
Type Waffle e ‘
Overall Depth mm
Slab Thickness mm
Stem Width at Top mm
Stem Width at Bottom mm
Spacing of Ribs that are Parallel to Slab 1-Axis mm
Spacing of Ribs that are Parallel to Slab 2-Axis mm
ok | [ cancal |

Notional Size Uata

Modeling Type

| Modify/Show Notional Size...

[ ShebThin

v

14y Time Dependent Parameters

Notional Size of Section
@ Auto

(O userdefined

O None

1412 mm
mm
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0d3) als oy 0s; b LiveS
R ol b LiveR
0u3 Oyl 0033 LiveP
4J3); X sbeal, 4335 L Qx
S35 Y s, J35 b Qy
S5 | s mes bX bl U35 b Qxn,Qxp
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e
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aalol o aS ol ol oolaiwl » NP oo @ jlade cowl oot dwlre A5 (o Al o ] 0 e aSl 4 g

W Am|5:’> C)Lol

oS o0 398 (6,105 ,L slaSIl Ly x5 4 pladl Define > Load Pattern jgius 5l oslaw! b

4y Define Load Patterns =
Loads Click To:
Self Weight Auto

Load Type Muttiplier Lateral Load | Add New Load I
Mass Other 0 e | Modify Load |
Dead || Dead 1 P - .
SDead Dead 0 T =mel e
LiveF Live 0 S e
LiveS Live 0
LiveP Live 0 | Delete Load |
LiveR Roof Live o
Qx Seismic 0 User Coefficient
Qy Seismic 0 User Coefficient
Qxp ¥ || Seismic 0 ¥ || User Coefficient v | oK | | Cancel |

o0 iy 5 )b (55801 ) o3 A S

L g Seismic g4 51 QZ L g55 5 .098 Dol a0 il Self-Weight Multiplier ., ;> SDead (s, a5 09 <3

s User Coefficient g4 5l aly); sla )b sy 048 wlsesl none i, Auto Lateral Load (5431

Mass Source o =5 A-Y

B9 (o0 dwlne Olab 00 Jb doyd s g 050 )b ggeme b plp leiBle (sl o)) p i SeSs o lesSlu (o

bl ply pleaslo glos ) oy 0 by e b s 5 cnl

Mass Source = Dead + SDead + LiveP+0.2(LiveF+LiveS)+Mass

Define > Mass Source giws 5l oolaiwl b (YA« + asl opol) Conl ool 48,5 a5 jo JulS job @ by cpis )b b aS

gd ooy Ve JSS Gllae (sl o) o2

3y Mass Source Data

Mass Source Name MsSrct

Mass Source
[] Element Self Mass
[ Additional Mass

Specified Load Patterns

|:| Adjust Diaphragm Lateral Mass to Move Mass Centroid by:

Thiz Ratio of Diaphragm Width in X Direction

This Ratio of Diaphragm VWidth in " Direction

——
——

*

Mass Multipliers for Load Patterns

Load Pattern

Muttiplier

LiveP 1

Livel 02 | Delete|
v v

Maco 1

Mass Options

Include Lateral Mass
[ nclude Vertical Mass

Lump Lateral Mass at Story Levels

oK |

| Cancel |
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s g olopass Gy a3 -4-Y

Bgh oo Jud VY S pille Wo o Julos 4 by e wlelass Define > P-Delta Option giws 5l soliiwl b

[ 4y Preset P-Delta Options

Automation Method

O None

ID Mon-iterative - Based on Mass
@ terative - Based on Loads

terative P-Dielta Load Caze

Load Pattern Scale Factor

LiveF 1

LiveP 1
Lives 1
Shead 12

Cead 1.2

Relative Convergence Tolerance

Add
Modify

Delete

| Cancel |

P-Delta Lo oleadass 0,5 Jud VY S

GNS L Y 5 yae ) Y

Sleplass 5 Ll g9 00iiS asine (5,105 ,b V> Define > Load Cases ,giws 3l eoliiwl L ETABS asl s 4o
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4y Load Cases #
Load Cazes Click ta:

Load Case Name Load Case Type ~ I Add New Case. . I
Dead Linear Static | Add Copy of Case... |
SDead Linear Static | Modify/Show Case... |
LiveF Linear Static | Delete Case |
LiveS Linear Static EI
LiveP Linear Static = | Show Load Case Tree... |
Qx Linear Static
Qy Linear Static
Cip Linear Static

GNE L oY VY S
5l DS 5 iy o VY

Gllao 5L5 990 Sla)l S 5 Cow i 29,5 (o0 B gl Lagi a5 098 (o0 plol (pla)l oS 5 bl ojle (AL
D5l oo B 4 YA 4l 0l s ACH

oy eSS et
Selete gl 03, Qx+0.3(Qy+Qz) Q1
seleie gl o) Qy+0.3(Qx+Qz) Q2
ol gl 03] Qxp+0.3(Qy+Qz) Q3
sl gl o3, Qxn+0.3(Qx+Qz) Q4
Swlate gl o) Qyp+0.3(Qx+Qz) Q5
seleie gl o5, Qyn+0.3(Qx+Qz) Q6
Selste gl 03, Qz+0.3(Qx+Qy) Q7
b 1.4 (Dead+SDead) Conl
S NE 1.2 (Dead+SDead)+1.6(LiveF+LiveS+LiveP)+0.5LiveR Con2
S NE 1.2 (Dead+SDead)+0.5(LiveF+LiveS+LiveP)+1.6LiveR Con3
e 1.2 (Dead+SDead)+1.0(LiveF+LiveS+LiveP)+1.0Q1 Con4
S NE 1.2 (Dead+SDead)+1.0(LiveF+LiveS+LiveP)+1.0Q2 Con5
S NE 1.2 (Dead+SDead)+1.0(LiveF+LiveS+LiveP)+1.0Q3 Con6
>,k 1.2 (Dead+SDead)+1.0(LiveF+LiveS+LiveP)+1.0Q4 Con7
e 1.2 (Dead+SDead)+1.0(LiveF+LiveS+LiveP)+1.0Q5 Con8
e 1.2 (Dead+SDead)+1.0(LiveF+LiveS+LiveP)+1.0Q6 Con9
S NE 1.2 (Dead+SDead)+1.0(LiveF+LiveS+LiveP)+1.0Q7 Conl0
b 0.9(Dead+SDead)+1.0Q1 Conll
b 0.9(Dead+SDead)+1.0Q2 Con12
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b 0.9(Dead+SDead)+1.0Q3 Conl3
b 0.9(Dead+SDead)+1.0Q4 Conl4
b 0.9(Dead+SDead)+1.0Q5 Conl5
b 0.9(Dead+SDead)+1.0Q6 Conl6
b 0.9(Dead+SDead)+1.0Q7 Conl7

Define > Load ,s5iws &,k 5l (6,138 ,L luS 5 0gd o yalate sl 095 lawgs gl o3,) b OVl aie cuadle
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Shell Assignment - Diaphragms -
Diaphragm Assignments W
Mone ! EE
| D ———— i
{4y Define Diaphragm >
Diaphragms Click to:
| Add MNew Diaphragm | ::)k ________ I
I Modify#Show Diaphragm I i
Delete Dj ﬂ" Diaphragm Data
O}
Diaphragm |D1
Cani
Rigidity
O Rigid (® Semi Rigid
| Modify/Show Definitions... |
[ok ] [cos= | [ et | — [ox ] [ cancal
— AN T T

W

Semi Rigid gg 5l 651,805 Sl VO JS
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Swles ol Select Load Cases aaSs g9, SIS LI, &5 5,135 L Y= Export Floor Load Only

14y Options for Export to SAFE £y Select Load Cases to Export to SAFE >

Story to Export Load Cases

Story StoryT ~|

Loads to Export

(® Export Foor Loads Only

(") Export Floor Loads and Loads from Above

- Qx

(_) Export Floor Loads plus Column and Wall Distortions Qy
Qxp
Load Cases and Load Combinations to Export %
I Select Load Cases... I 0 of 13 Cases Selected gzn

| Select Load Combinations... | 0 of 24 Combos Selected
oK | [ cancel 15
ok | [ cancel
&)
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dled 0,33 a5 5 550 yus 0 |, LB OK aeSs 155 b ba,b Gl 5l o
I, b, File > Import> Safe F2k File... .ol Import 1,V o8 L SAFE asb, jo SAFE aoliy ,0 ls5/,8.Y
aaled 0235 Slo>1 8 51 o
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Assign > Beam Data>Properties Modifier...

05 a3 3y 359 9 oy Mol culpo bl jo asles syl <8 il |, Moment Of Inertia About 3 Axis s .o

Jol> lsbl Define > Beam Properties sgw 5l ol o oy s (55,05 S5 oo Jlosl gl a0 (Y is)y)
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Define > Load Cases>Add New Case...
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Load Case Data - Nonlinear Static 1 =
Load Case Name Load Case Data Motes Load Case Type
[petmieL [ Modfy/Show Notes [ Static v| [ Desian
Initial Conditions Analysis Type
@ Zero Inttial Condttions - Start from Unstressed State O Lnear

() Continue from State at End of Nonlinear Case

e

Important Mote: Loads from this previous case are included in the cument
case

O Norlingar (Allow Uplft)

® Nonlinear (Cracked)

(O Monlinear (Long Term Cracked)
Creep Coefficient

Shrinkage Strain

(O Continue from State at End of Nonlinear Case

(® Nonlinear {Alow Uplift)
(O MNonlinear (Cracked)

Loads Applied Uplft Solution Control
Force Convergence Tolerance (Relative)
Load Name Scale Factor
v |pesd ~] 10000
SDead ~ | 1.0000
LiveF ~ | 1.0000
LiveP ~ | 1.0000
LiveS ~ | 1.0000
. ~
Ai,D-l—L ujl} D s \V Li..u
B Load Case Data - Nonlinear Static 7 X
Load Case Name Load Case Data MNotes Load Case Type
‘Deha‘i.D Modify/Show Motes... ‘Sbaﬁ: V| | Design...
Initial Condttions Analysis Type
@ Zero Inttial Condttions - Start from Unstressed State O Lnear

O Nonlinear {Long Term Cracked)
Creep Coefficient

Important Mote: Loads from this previous case are included in the curent
case

Shrinkage Strain

Loads Applied Uplft Solution Cortrol
Force Convergence Tolerance (Relative)
Load Name Scale Factor
b |Dewd <] 1000
SDead ~ | 1.0000
LiveP ~ | 1.0000
. ~

Aip o iy pas VA JS

o b cpl szl Gglad a5 S ge jo Sl ool (L3, 00 10 b wlie jud cpind b oady )L L A5 0ed oo alaxde
2 a bgrye 2led 5L w5 b sle il b a5l e 10,8 Bl ) Gl 00 Sk 4 bgaye alex s
1398 (o Gy ) s 5l (S

Define>Load Combinations>Add New Combo...

s oo i | abgy e T L SVl 55,8 s s K 14 S5 aF
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ﬁ Load Combination Data ? *
General Data
Load Combination Name |Deha.i.L |
Combination Type | Linear Add ~ |
Notes [ Modiy/Show Notes... |
Auto Combination | No

Define Combination of Load Case/Combo Results

Load Name Scale Factor
Deftai.D+L ~|1.
. ]

Design Selection

[ Strength (Utimate) [ Service - Normal
[ Service - Intial [ Service - Long Tem
OK | | Cancel

Sl 4 by )b S 5 s N S

Slp Saeilys 53 Jol Jad F-0 as Slvsgs gillae ke 0 4 b bgpe () 0 LS 5 Y e O
1398 (o0 dlone 2 b S
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¢ 2

S oo dmlos | Aoy 9 410,00 ulpo It

1
= 0.917

Ato,0 = Ao — A

e® ~ 11 50p  1+50(0.0018) 1+ 50(0.0018)

o P et 4 Sl odd o3 e VA L den o ls g lad el

AtO,OO = /‘{00 (

2
1.83

T 1+50p 1+50(0.0018)

ol o

A= 0'917Ai,D + 1'83AiL,S + Ai,L

el ploa o 55 A p 4 bgrye o 8L o ot Gy ST S s 4 bgyye o8 0 Ay b as e 6 051 oS 5

(Y‘ J.i..;) rg.u.f ga.:).xs ‘) Ai,0.25L+D Ls)‘df)la u.][} w‘ m}l AL,L A.ML?:A 6‘;: w‘ ol .b)|5

(O Cortinue from State at End of Nenlinear Case

Important Mote: Loads from this previous case are included in the cument
case

Loads Applied

Load Name Scale Factor
Dead o 1.
SDead o 1.
LiveP o 1.
LiveF ~|0.25

4 LiveS | 025

- ]

ﬁ Load Case Data - Linear Static ? *
Load Case Name Load Case Data Motes Load Case Type
[Detta i.D+0 251 Madfy/Show Notes .. [static v| [ Desgn..
Initial Conditions Analysis Type
® Zero Initial Conditions - Start from Unstressed State O Linear

O MNonlinear (Allow Uplfty

® Nonlinear (Cracked)

O Norlinear (Long Term Cracked)
Creep Coefficient

Shrinkage Strain

Uplift Solution Coritrol

Force Convergence Tolerance (Relative)

0.001

oKk | [ cancel

Ai02504D & by )15 ,L b Gy pes Yo S8

(V) USS) 09 o0 iy yo5 BB AL g 4 basye 6,05 ,L oS 5 s 5 ol &

Ai,L,s = Ai,o.25L+D -

Aip
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ﬁ Load Combination Data ? *
General Data
Load Combination Name |Del:a.i.SUS |
Combination Type | Linear Add ™ |
Notes [ Modiy/Show Notes... |
Auto Combination | No

Define Combination of Load Case/Combo Results

Load Name Scale Factor
b |DettaiD+0.250 ~ | 1.0000
Detta i.D ~ [ -1.0000
& S

Design Selection

[ Strength {Utimate) [ Service - Nomal
O Service - Initial [ Service - Long Term
OK | | Cancel |

ile la)ly 53 4 gy o Jb oS 5 VY ISS
29 g0 S VY KD Bllas jBaile 53 4y bgaye )b oS5 Cals yo

A= 0'917Ai,D + 1'83AiL,S + Ai,L

ﬁ Load Combination Data ? >
General Data
Load Combination Name |Del:a.Long Tem |
Combination Type | Linear Add ™ |
Notes [ Modiy/Show Notes... |
Auto Combination | No

Define Combination of Load Case/Combo Results

Load Name Scale Factor
Detta i,.D ~ | 517

Detta i.SUS ~ (183
Dettai,L ~|1.

Design Selection

O Strength (Utimate) [ Service - Normal
O Service - Initial [ Service - Long Term
oK | | Cancel
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Do 3 > 4 bgrye b oS 5 VY S
plosl 103 a3l (S0,95 S as by e Olendas . LS foo 5 (6,50, Koo Slamtine g fdoi Olaliis ploxil &
Wy (o

Run > Cracking Analysis Option...
5 L8 (s las e g Sguzme 1yl Jelod gl o 2510 e YT UK Gillas 99250 slo S, (s )
G)L».‘ 9 Qj...\.?bo ‘P‘ L..L?u ) )‘ ool La ML‘).' 409.3; < oolaw! sML‘ <° u)‘)} 9 8l S " 5 )J‘).' as u.ul.‘ JBL.\? ;A.A.MMS W
Colure (S g 5Led (gl oo Gy a5 JBlao ladie b ] dnglie g ol ciy pa5 (6,108, SlaS 5 9 Y 6l o
B 5o anslome IS oyl 4 az i b ol @l (Jg o) (ool sl (o) ol S oo il 1) (s (sl Shes

D9l oo A g3

ﬁ Reinforcement Options For Cracking Analysis 7 x

Reinfarcement Source
(O User Specified Rebar (Slab Rebar Objects)
® From Finite Blement Based Design

(O Quick Tension Rebar Specification Bar Size mm

Top Reinforzing |

Bottom Reinforzing |

Minimum Reinforcing Ratios Used for Cracking Analysis

Tension Reinforcing 0.008
Compression Reinforcing 0.0018

oK | | Cancel |

S5 S5 el sl 5l 00 o Mhe @ Loy je Slialais VY IS
(VF o) 05 oo olbusl aali py Loy o1 fir bl 5 00l Clsesl 4ol oyl ay 4z g5 b aolip bawgs  SisecnS Jooe

Madulus of Rupture for Cracked Deflections
{® Program Default {Based on Concrete Slab Design Code)

) User Specified

S Jyso iy V¥ IS8

13,00 o 3l CSI el 135 5 (o s L6 Define > Materials sy 51 s o gllas cy a5 50 Coond

Modulus-of-rupture value

Created by Mike Abell, |35t medifizd by Truly Guzman on Jun 21, 2017

ACL: As recommended in the ACI 435R95 report (section 4.3.3},5AFE uses a default modulus-of-rupture value of 4+f ' PSI
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A3l oo Hlaedsl Caz 0 Jg (058 o plsl ACT 435 oy s gudo diloe) ol (o3 ACT asl oyl Gollas jlaie oy
fr = 0.64/f.
(sl N-mm o a>1g) 5,5 eladl User Specified e 5l o1 oMol 4 s (olulpp Glg5 o0 45
g0 0l ad )8 lai o iy Jlo 18w VY e 5logd e dogl aS ol Cowenl 1 ]S gl gus i o5l
Caw! ‘5...:).»....40 JJ[S )J))...m.a)‘ p.a-l‘?a.} L)"‘ el 00 4..3;).’4;)0)...0 GULMJ g ).»‘).: )‘AM U"‘ L‘>r...>|
Run > Automatic Mesh Option...
0] e (YO JS2) 09 g0y o dguzme izl (> (sl o1 0,8heo 5 1o 5l5 Gliee e 5o

Design > Design Preferences...

## Design Preferences 7 x

Code | Min. Cover Slabs | Min. Cover Beams P/ Stress Check

Non-Prestressed Reinforcement
Clear Cover Top {mm})
Clear Cover Bottom {mm)
Frefemred Bar Size
Inner Slab Rebar Layer Layer B

Post-Tensioning

NlE|s

CGS of Tendon Top {mm}) 25
CGS of Tendon for Bottom of Exterior Bay {mm) A0
CGS of Tendon for Bottom of Interior Bay {mm}) 25
Minimum Reinforcing
Slab Type for Minimum Reinforcing Two Way
| Reset Tab Defaults |
| OK | | Cancel |

JIs ouls w595 0, Xe o5 a5 YO S

el Cewdy Y8 S illae o 510 g ST lays mls Judos plsil ) o @l b ,) 5 el ploeil Y
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(9 05k e J S g 21k F

g8 J7S 5 el 5o b alie sla o3le 10 Joeme 3190 (Jlod 5 0Bk (od Py sla Bhas 0T Suond (1
U5 curs g ojle 00 drnlone -

Ll oy 55l Jlosl -

S Dope 5 (9,5 S cmlps U5 g el capd s st el o)) -

e i -

@ slojlps (b Sledas -

b g Jelos ol g (ldas ol Slegdass -

(2D 0.25 s oo i po sl (&b S5 -

(o3 IS L les gl bl 5o 50 05le it J 55 -

o5 (ohomn & Sl sl -

oS oo Sz g Alie a4y pladl ol Ay o 2o dnwle Sl YUY Co B g 0g  dewle

GBIl YA+ ael o] dogs Gillas al> o 0l (6l = 5 3280 Judons plosil gaum 0gs p dusline (50,95 S5 culps -

D9 (50
<0 o
\ )‘ﬁu}
YO ”‘Jb

(YA JS8) o oads Mol (Fo,55 S 5 clpd bl il
Select>Select>Object Type...
oS oo pla3l LT Pl 4 s 5 uanns 51 (Wall/Column/Beam/Floor) Ll g4 a5 dws usnw

Wall / Slab: Assign>Shell>Stiffness Modifier...

Sz Sl o 3l plol 5 solu [ 1y 04 5 Slowliee el (51,3bs olaisl b g <d )5 L s Membranel, s g5 oles oo ¥
2,5 Jd s 39y Al sl |y Lo o Jdow o6 )laubl 5 el Lo 4 ¢ g, ol 5l eolasal
Josd BB gy b sl o s Jlol b ens 383 o5 ol o ool 1l aalipy JBlg I8 Gy pa3 led 5 Lx] )5 a8 354 4z g5 28
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Beam / Column: Assign>Framel>Properties Modifier...

Shell Assignment - Stiffness Modifiers Shell Assignment - Stiffness Modifiers n Frame Assignment - Property Modifiers

Property/Stifiness Modfiers for Analysis Property/Stifness Modiers for Analysis Property/Stffness Modfiers for Analysis
Membrane 11 Drecion Membrane 11 Drection Cross section (auzl)Area L1
Membrane 22 Direction [ Membrane {22 Direction Shear Area in 2 direction
Membrane f12 Direction Membrane 12 Direction CR— Shear Avez in 3direction [
Bending m11 Direction E| Bending m11 Direction Torsional Constart
Bending m22 Direction Bending m22 Direction 025 Moment of Inertia abou 2 axis |
Bending m12 Direction [ Bending m12 Direction Moment of Inerta about 3 axis
Shear v13 Direction Shear v13 Direction l:l Mass
Shear v23 Direction Shear v23 Diecton Weight L]

wieign Weigh
OK | ‘ Josz ‘ | Hply | OK | ‘ Close ‘ | Apply | (L | ‘ e ‘ | Aoply
s gl , [eey
s Ellpe s

Ogdy Ml?r.c ‘_g‘).a 6‘ o)Lw LgLa.c‘ L;Q)P J)J w‘ro YA ng
aaSs 85 g Modal Ll b s g Modal Cases... 435 Define g4 5 aoge olows oudas -
WS b a0 g Y dib ja oljl 4 laoge slawd ouiS oo euhaii | laoge olaas Modify/Show Cases...
SIARER RS

Maximum Mumber of Modes |12 |

T PRV K J.:L‘B Py R )‘ L,;Lo‘ ‘_gl.bdy).s J.».l?u lol?u‘ )‘ o= Yﬁb.La‘ LgLQ:»)}:)J C‘)’L"“)‘ 9 J.».l?u lol?u‘ -
Display>Show Table

Ly 890 ol 50 o ol azg5 BB platels sla loisle j8 iy 8590 ol atils XY sbisl,) jo S cdls o Lol slag ol (s 22
Sles alasde b ojle Sealins <3S, aslys oo
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=[] Tables
&-[ I Model
EI--Dﬁnah'sis
- ]Options
|:| Response Spectrum Functions
--|:|T|rr|e History Functions
|:| Load Cases
|:| Load Combinations
E||:| Results
|:| Displacements
|:| Reactions
£ Modal Resulis
Modal Periods and Frequencies

@[] Structure Results
@[] Frame Results
-] 5hell Results

- EnengyVirtual Wark
-] Design

kol srog p alaxde YA S

by M‘}} ).:) )‘).9 L o)L.u (él.o‘ 6&094); ).:..)LO.A

ot L o5t

Modal 2 0.426 i

i b bl el 6l 25 Jooor Billae A3l o pd (ol slaog  polie sl oslitul b aljly cu po dslons -
(\.\.wl.: ) él.l) dalaio ‘5)0 o))J).b 9 I s w) Js.w = AML?LA 0)45 GA-AJ ng).:)‘}nb

) po dmwlxo

To= 0.15 0.15
Ts= 0.7 0.7
S0= 1.1 1.1
S= 1.75 1.75
T=Min (=125 ;) 0.55 0.50
C=A.B.IIR= 0.165 0.165
k=0.5*T+0.75= 1.03 1.00
CoRiFT= 0.165 0.165
KoRriFT= 1.03 1.00

05 o0 0,253 Period.EDB lsic i 04 drles 6
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Olyie <o 1) 0T 5 oS (50 5k 0b 0olel g b gl al o p0 05" (Lol B Lol Bl o a3l alyo (talpg -
) a3 o0 e a3y o po Sl eslaiwl b1y gl o)) (6,108 ,L OV adS s ouiS o0 0,53 LRFS.EDB

oS 0 Uilng
Define >Load Pattern...

o o>y BB Cules )0 oS (oo Ml 392 Jour 4 az g L) ca s i sl o) ) 5l SV TSy e sl s

.w—:—;S
Lael 53,55 S culps Jlasl T

Ol 3l G el (5See 0,8 edlg (6l 05 ) i (b (gl Lasl (S0 65 S ol Jlesl @ pladl als e ol g0
A dales oLl T a dslsl )5 a8 all culps (S ol 5l ceaiel Sbj)l il 4 Az g b g ad> e

S 5 gy 5 plas BRI 51 gy e ol Ky b o azl allas Lo a5 Lo 5,05 S lps -
(3l o 5ozl al el 53 llls (T3 S 0 aSul 4zl L) 950 (o Jlosl - YOl Ll (ptes (S0 )55

o5 wl>Assign>Frame>Properties Modifiers

Frame Assignment - Property Modifiers Frame Assignment - Property Modifiers

Property/Stiffness Modffiers for Analysis Property/Stiffness Modfiers for Analysis
Cross-section {axial) Area Cross-section (axial) Area

Shear Area in 2 direction Shear Area in 2 direction

Shear Area in 3 direction Shear Area in 3 direction

Torsional Constant Torsional Constant

jury ry =] -y -y v v v
(X}
L

Moment of Inertia about 2 axis 7 Moment of Inertia about 2 axis
Momert of Inertia about 3 axis 7 Momert of Inertia about 3 axis
Mass Mass
Weight Weight
ok | | cose | [ Aoy ok | [ ose | [ Aepy
LT Lin 3

o (s 5 oy e sl (F2505 Iy o S

(T JS2) wdl (o0 =Y (50,95 S5 cuypd 5 o (gt 3550 50

Gl &S Hho &y Su03 (5 lake) Cuwloads jslate c N by Ll (F9,05 S5 po Il (F055 ST ey o -
(S dnzlye G Jab ¥V ooz ) meosi 4 WSS obnl (A 55 ddod gl o (ST Glie 4 (5w RalS

las oxus>Assign>Shell>Stiffness Modifiers
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Property/Stiffness Modifiers for Analysis
Membrane f11 Direction
Membrane f22 Direction

Membrane f12 Direction

1l

Bending m11 Direction 0.01
Bending m22 Direction .0
Bending m12 Direction
Shear w13 Direction
Shear w23 Direction

Mass

— — — — [=]
=

Weight

QK Close Apply

LIs (5,55 S5 s T S

Jad) 05 o yslate - YO L -V LT (50,55 S5 as a)lns (F0,55 S5 oy o)l (S0)55 S g -

f. = 0.6/f) =3 MPa

ol 0,95 S5 slojlps (sln G g 08 (o0 poaie <V L Rl o jlgs (5w 2lal o b dul S5, enl 6
(VY JS5) 0,5 pules C)Lol Iy polie

lo,lgs0 wLs>Assign>Shell>Stiffness Modifiers...

Shell Assignment - Stiffness Modifiers

Property/Stiffness Modffiers for Analysis
Membrane f11 Direction
Membrane f22 Direction 70
Membrane f12 Direction
Bending m11 Direction
Bending m22 Direction
Bending m12 Direction
Shear v13 Direction
Shear v23 Direction

Mass

Weight

o] [ ] [om ]
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e e ooy
{4y Load Combinations i e | SN - = .
4y Load Combination Data X
Combinations Click to:
General Data
Conel
Cu:Z - I Add New Combo... Load Combination Name ‘WalCrac'kCﬂnbn |
Concd "
Concd | Add Copy of Combo... Combination Type ‘ Envelope V|
Conc5 -
Gores | Modfy/Shaw Combo... Notes | Modfy/Show Notes.. |
nc
Concl | Delete Combo Auto Combination ‘ Mo
Conch
Conc10
Conc11 | Add Defaut Design Combos Define Combination of Load Case/Combo Results
Concl2 g =
Conc13 | % — - C Load Name Scale Facter ~
Conc14 onvert Combos to Monlinear Cast
@:15 w Conc2 Add
Concd

1
1
1
Conch 1 M
1
1

e O Conch
-

[ ok | [ Cancel |

T s
sl ojlo slajlend (59,05 S5 (omyp ln g b S 5 YT S
1S o0 oy |y Bl sla 205 822 adlge Sy oS 1S oo Julos 1) 03l JLSS 4398 5L S 5y 5l oy
(N-mm) oy Sl sl axlg 4 azgi b o ¥F S Billas 5 o (o0 )Lid 1) FO ol o 51 ey jekain ol @
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Load Case/Load Combination/Modal Case
() Case (® Combo () Mode

WallCrackCombo ~ || Absolute Max ~

Compornent Type

Shell Stresses ~ | | Vizible Face ~
Component

Q) 511 () SMax 513

@® 522 ) SMin O 523

O 512 O svM O SMaxv
Contour Appearance

Contour Option Display on Undeformed Shape ~

[ Show Lines

Show Fill Transparency 0.0 w

[1 Show Values

Contour Values

Min/Max Range |-3 | |3 MPa
Contour Averaging at Nodes By Selected Groups ~ || Groups...
Scaling
Ok Close Apply

b lgzs (59,55 S5 oy ¥F IS0
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sl dalsss 1 1 (6,86 imel b s Comdg o)y diwd 00,55 S 5 b lgso aSul 4 4z g5 b 09 o 2L

Isazte Bl (59,95 S 5 o pd pdd DHgo ;0 ow) 2 Geed Dbl 03,95 S 5 b jles il Sed &S S50y S
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%

/i

(L

Y

9% %

-0.23

023

-0.69

15

)lgs (5,95 S5 gw)p YO S

ol oo S 5 oizmy ebiol L1 Y

@bl bwgio 4 (oo (ol iSlas Cond jlade 5 s Sl oSl plosl Sl Gl Coxdy J5S 6l -

(CUHT Sils 0llS L) S (oo smpn |y 051800 (oo

Display> Show Tables> Analysis>Results>Displacements>Diaphragm Max/Avg Drifts

Iy sl o) ;b &Yl Lads g 00,5 conl, SIS Load Case/Combo ;ygiw w59, 09 (oo b a5 (saaz o, 5o

Cuaz Hlod ;0 1W513L0  cwyp 9)50 Ll o gl iteM ain 1o a8 asS C8s (W1 A s a) S o ol
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Load
Story 3ze/Comb ftem Max Dirift Awvg Drift Ratio
b |Storys aQy Diaph D1Y 0.002709 0.002447 1.107
Story4 Qp  |DiaphD1Y 0.002523 0.002449 103
Story4 Qn  |DiaphD1Y 0.002898 0.002443 1186
Story3 Qy Diaph D1Y 0.002547 0.002295 111
Story3 Qp  |DiaphD1Y 0.002366 0.0023 1029
Story3 Qn  |DiaphD1Y 0.002728 0.002291 1191
Story2 Qy Diaph D1 Y 0.001991 0.00179 1112
Story2 Qp  |DiaphD1Y 0.001845 0.001794 1028
» Qx Diaph D1 X 0.005895 0.005329 1.106
Story4 Qe  |DiaphD1X 0.006392 0.005375 1.189
Story4 @n  |Diaph D1X 0.005399 0.005284 1022
Story3 Qx Diaph D1 X 0.005407 0.004845 1115
Story3 Qe  |DiaphD1X 0.005895 0.004893 1.205
Story3 @n  |Diaph D1X 0.004919 0.004805 1024
Story2 Qx Diaph D1 X 0.004118 0.003674 1121

iz ool oy TF JSS

SYYSY an YA el il Gillae (Gl Jled i) sl 035k s 4 4255 L ol (sinoll 2 oy sl -
@ axg b oS s ol glas)) 1) e Job 55 oo ey 35 10 Coons o sl dilas Slaws obs,l gl | Con8 ¥
2 50 ole guxel oo (plply 0 dales ¥l i Jlie ol o be ailes slawy dads glaiyl g B)b jo j0 o jlgss Job

e S DL (B0 (o) 2 Sl Bk (o0 il B 00)d TO Sl A SlEL (B Glie 0B GaleS VY L pl Bl 9
Display> Show Tables> Analysis>Results>Structure Results>Story Forces

bl ol el )3 s (o0 )18 (o) 2 Sjg0 JuuST 0l (o a0 (B Cond (o) 2 Sln ) @S e
27 W) S oo e Ay pe 0 Lol (el o po S o o aaleS VY pln oS (nl bl et
(23 oo (el po Jlosl & (555 a5 051805 (b g i yo JpuS Sl

S (o8 518 (o p 90 5 e 5l 03l b (Bl 3 e 5l g3 polie WS sl Al o pS e -
Display> Show Tables> Analysis>Results>Displacements>Story Max/Avg Displacement

il pln wdl (o VY s lib pled )0 g Liwl) 90 10 (glp Cad (] a5 das oo (Lid polie (g

Amax
A= (2 2 <
J (1.2Aa,,g) =

2o o o)l canlio + B (B8 i Cu3S e g ke cplple

Ol pbaiel slo o3l jo el (BUS o 35 e j0 Cdy o S ol og chom pbaie 4 dax i b0 [ Y
25 oo el (M sla aligS yo ]S
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D (g0 ool 35 Sy S5 sl b L (Soyt S calye les I -
T oelS oo 4> QY 5 OX sl o3 o)l slp 1y ey 350 sl mlmle ) e 5| Jdos plol 1 ey -

Display> Show Tables> Analysis>Results>Displacements>Diaphragm Center of Mass
Displacements

Export to an;5 Jgax 59, cowly S b s 035 0 Jleé 1, QY gX « Load/Case Combo g o
YA aol oyl ollae oS o ol 1) Excel

0.025h
Ag= CyA,< 0.025h - Ay < ———< —> A, < 0.005h
Cq(=5)
Al oo ks g0 il glis | B as
Story | Diaphragm | Load Case/Combo Ux vy Uall
Story4 D1 Qx 49.95 64.7
Story3 D1 Qx| 32.647 49.8
Story2 D1 Qx| 16.886 32.2
Story1 D1 Qx 4.962 16
Story4 D1 Qy 24.011 64.7
Story3 D1 Qy 15.959 49.8
Story2 D1 Qy 8.438 32.2
Story1 D1 Qy 2.554 16
mm mm mm

g (o0 (bl camlio a0 Gl Gl
syt sloy oo b Sladii
gl ads ool V.Y oael oo 4 azg b weo,S o jb lateralledb LG @ loose . ol oy Slas/ -

OV o dn 0 ]l Gl (o0 oS (oo JS0 L) sam S e 005 Rl VY )l ) L L L e 61350
(VY JS5) oS 015 o Scale Factor v pw 55 5,135 ,L

calpo do o ol o el oY & jganl pi 4o el Cwty (LSS Lasl oles Judody i y0 435 culps oy polie 4 dzgi b Jle ol 0 30
23,5 Jlis J55S Jolhe ple s 9 Si9d Dol 35
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14y Load Case Data X
General
Load Case MName | | Design... |
Load Case Type | Linear Static “| | Notes.. |
Exclude Objects in this Group | Mot Applicable
Mass Source | MsSrc

P-Delta/Nonlinear Stifness

(®) Use Preset P-Delta Settings hterative based on loads Modfy/Show
(O Use Nonlinear Case (Loads at End of Case NOT Included)

Nenlinear Case |

Loads Applied

Load Type Load Name Scale Factor

Delete

G ,L Y o el o o Jlesl XYY S

Pier s 9 coé; ul;w‘ |) ksw).: Lgl.b)b.‘a'é )‘ r:l..\S S Pier [ ] uoLA.«.?‘ 6‘ﬁ u.w/..: d[ﬁ)/}gdpier [ w).y—

S WS e oolaul o b g les avain aid Glp 6 )S ez il Al e oo olais ol eSS

o 48,5 L )0 Iizme slo PIF Ll sy g 958 (oo iy o PIET S O j90 4 WS al>po (nl 5o IS L Jlos a5 0
Assign>Shell>Pier Labels...

Pier aw 4 al> 0 opl ;0) swsles SIS Modify/Show Definitions 4sSs (g5, « i o cons p <y 15 5l

(o035

,lg0 (5,108 oz 5 YA IS

117
sle gl



oo (rwiige sl By Gldls (b sleial,

Design>Shear Wall Design>View/Revise Preferences...

‘0)99 )))Lv )|5:'.\> pw LY Joyj.a (@l}ul} LS’LAj))" w]@) Cd w]o lDL..)‘ )J NE G- WL».A uLo...la,.u )...u.....) yw
(Y o) sl oals 2ol (lgss )b & 5,5 Cos ) Utilization Factor oo g oo,e ooy oV38 00,

|4y Shear Wall Design Preferences for ACI 318-14 X
tem Description
ten Vae A| | | oo e doigh of a pr it
03 | Rebar Material 5400 a Uniform/Section Designer section
04 | Rebar Shear Material 5300
05 | Design System Rho 1
06 | Design System Sds 0.5
07 |Importance Factor 1
08 |System Cd 25
09 |Phi (Tension Cortrolled) 05
10 | Phi (Compression Controlled) 065
11 | Phi (Shear and/or Torsion) 075
12 | Phi (Shear Seismic) 06
13 | Pmax Factor 0.8
14 | Number of Curves 24
15 |Number of Points il
16 |Edge Design PT-Max 006
17 |Edge Design PC-Max 0.04
18 | Section Design |P-Max 0.04
» 19 | Section Design IP-Min Explanation of Color Coding for Values
20 | Utilization Factor Limit 1 v Blue: Default Value
Black: Mot a Default Value
Set To Default Values Reset To Previous Values
altems | [ selectedtems | [ aitems | [ selctedtems | Red: }ﬁ“;‘r:;:‘:zg“:r:‘ ged during

B Sl b 5 S Slondas YA S

4 s b sl 1o e (sl sl s ol Sl gy o alog oo 3 s Sles o515 & i o3 4 4z
Al o ol 5l e el sz ool alS s s ol Lris] )0 098 jekaie aslp (58 i chal Sl 5 (T/C o,
i o0 JAS ) (b I8k Sl

Design>Shear Wall Design>Select Design Combination...

sas 3,13 Design Combinations cud ;o ¢ Jsl cond ;0 oo iy 25 (5,138 ,b LS 5 adS a5 oS o J 0S8

sk
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4y Design Load Combinations Selection - Wall Design H
Swength
Choose Combinations
List of Combinations Design Combinations
ol ~
az Conc?
a3 Coned
a4 Concd
G5 Conch
[rii] 3 Conch
o7 Conc?
WallCrackCombo « ConeB
[« | |t
Cona10
G
Cong12
Conc13
Concld o
OK | ‘ Cancel

o oles Fhb bl cus s s ¥ IS
b 5 el plnil 5 s jledo plpi Sl i P

p3Y s Gravity g5 5l o3sn ool 3o by 9 b g aSol 4 425 b layd 5 o gt 4 bgy o Clonisr 25—

(i 1) b c09d (ood dmslons Ll )0 0ad Sloml glog s 1525) 098 Jlad Wil (sl (ool (g 0y SIS 435 s
Jolas Lacl (plogd oo dlpiiny Jlo 2 0 aisd (6 )08 Dguls 039 O ygo s Sl p3Y (6 1080 Ko al> 0 o S

Sl U slo 5 b NONE (sl 15 1ol 45 598 30) Lisgies g b3 Sl 5 a9 J S Lawgie 6,y S5 sl
Design>Overwrite Design :xigs )5 >,k Jeads 5l il 60l g 5 (6,105 ,L alos] Bun b 1ads a5 oS

:(No Design «,;5 ol g Procedure

Design>Concrete Frame Design>View/Revise Overwrite
ol pedle s caslie Bloudas ple oS o ol SWay Intermediate g5 Framing Type .. 4
s | b S Slelais
Design>Concrete Frame Design>View/Revise Preferences...

i u-“] aS 0 CB0 odl S Slewda g0y 40 lakd aiius caslie B8 o Sleudan Ll aied S g
b ouls ol ACI 318-14 b

oS oo Sl 1 05l g aSo b F5 ols 105 b 598 wladass plxil 5l oy .l gl Lol il 5 el ol -

5 s 955 o0 dpogh 3,5 weblyn b g 5 Wy >Lb 4y pladl i aaSs b gie b 5 b SAft + FE 0S|y s
25 sl Oy g iy 5o Check el (o, Jld L T Jsb 0, 8hs o (52 ()0

axg L General g, 5,38 o Lol jo g e >k 6lp Loy, aw ETABS sl i sl lpo 1L -
L ULTL 6lajlses sl a5 anled azgh wik (oo (20 sb)led (Fob (h9) Cnyie «Beds 6,159,800 (el 4
thio b 255 sl lgo | Simplified T/C Design s, s Uniform i, .o S eslasl General i, 5l sl

g el (o03 QLS (pl ggdge b (il ooly (SoSx g o oy, 51 o o JolS 20 all (o0 eslinnl BB CSleiSs
eled anzlpe QLS calu b8 a5 b (s gl o5l (P ib (cages oS @ )5 s, ) a5 sl s oo b
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(D 0.25 b s o sl oo S35

s (b 5 4 pldl Al o ol 5 Sl Sl e b 553 ezl I (e s Sl 4 a4z b
Iy (% p s Jlie cpl 50) 5 )b e lo Gldl (o (Gl VO ies S5 R85 ks e b ol b
U"‘ B ;.\...ul) )‘Jf).ula 63‘9.9 6‘ o)lg: o ‘5...:).' du)‘yo ADM)‘ C)l.‘> wo.‘> 6‘,) Sl uio.n Sy90 U"‘ \A-A-S‘SQ J)HS

Sl o Ha8 o ]S ol 5l e
(k) U Ll sl Lwly s 50 o5l Jituw J S A

5o Sge 258 Ol 095 4 oSl Sl o sl Lol Gl Sl g 2isd Jolod 5 (6515 ez L
18.10.5.2 Unless a more detailed analysis is perfonmed, E18.10.5.2 Where wall sections infersect to form L-,
effective flange widths of flanged sections shall extend from T-, C-, or other cross-sectional shapes, the inflnence of the
the face of the web a distance egual to the lesser of cne-half flange cn the behavior of the wall should be considered by
the distance to an adjacent wall web and 23 percent of the selecting appropnate flange widths. Tests (Wallace 19963
total wall height above the section under consideration. show that effective flange width mereases with increasing
drift level and the effectivensss of a flange in compression

differs from that for a flange in tension. The value nsed for
the effectve compression flange width has little effect on

the strength and deformation capacity of the wall; therefore,
to siplify design, a single value of effective fange width
based on an estimate of the effective tension flange width is
used in both tension and compressicn.
b alols cral jieS lade ojlasl ay ol azg 5l ol S L slalgro pdai) Jlall ablio jo Jb Sge (o, i pl @illao
Oy S 3ubd Judow aSST Ko 09 Gl anlllas 0,90 ahhie YU jlass S elai )l as )0 YO 5 jgle (sl o3l Sl
el 1y el ol 5Ls 0,90 80 (558! oy Judos duoy oo 5 4 g conl Slads o ol g5l ooly aSul 4y 4z g5 L o5

3 ilad i |yl ) e (sl 1) 5 sl (95 g ol (e &) 5 & 35 50 5 o)l
St L) o (o5t S8 e cyg0r 5 slalss b J S Gl (hny i oS | b il ¢ sl 30
s 28 5o g 85 5 )5 ke b 5l sm + S et L S S e g | (L
Gt e Gl D550 50 S cnl oS U558 ) )l (b o B sle g 00,5 Jake p 99 5 g il (e
Ol hgd> D9 b (o (elaiel (o) 2 (rlp ogdle all Coenl Pl Sl (Seo 20y Ve Sl s 4 Lo (gt a0y
L o5 Sk pis Y (G 2hb b 3gd (o0 oy Jlopp 4 Sl 0ad dpogi oLl (B by 56 b gt
5Ll s 55 1) LT (958 0 b il 2alS (See 0o b (i 8 sla G 95 i 45 wled 50 S0y 5590
Ded (653 ol (6,8 Slalgal ol alauly 4 L§->11,J¢> ailyd o saioes 5L aes oS lie

Slojles 0550 po Ly 5o gl JEne &j50 @ (5550 Oledl S5 5 o lses alilaz (6135 Gy ()8 0,505, S plsre & b nl L *
e (oo dngd A laz L S Lul) o gl cdlowyl jo 0gd oo dpogs WL
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N 52
5 Z 2
bs‘, < [‘r‘:" bg[ S {h‘% br{ S {h‘TW
et 4 — [ r—t———
|| |
i |———
32
by < [hi
+
L || |
et 51 i et 52 —

slosle Jlws oo (oye hym Fr IS0

oS oo 4 LateralTorsion.EDB el 4y S asens S L6

13,00 oo Lo ACT ael ol aSol @ as g5 b iy ot oMo/ oy dales -

22.7.3.2 In a statically indeterminate structure where T, =
& T, and a reduction of T, can occur due to redistribution of
internal forces after torsional cracking, it shall be permitted
to reduce T, to ¢ T;,. where the cracking torsion T, is calcu-
lated in accordance with 22.7.5.

S S5 S Pl s e I gk el oo ©)le 4 a8l (gileen g9 5l 15 i &SS9 0
i 8,559, ool (65ke 00ls (6l (somiive Sl 58l 05 50 ols LnalS BTy a1y adaiie Ty lgs (oo wil axils 349
g Ty alamdo 015 o 1,8 solaiwl 5,90 Mad a5 gy (abl oo o pud )L, SO S > 10) sl ooiis o
st e Sl Syl 0gd K05 BTy a4 Sen 9> b Ty a5 sl (6958 & (i (S5 (Bl pd i
9 Jelod ojle ol G s (@l (9) 08 (o0 PR ) Rlp (i (B o pd dal polaie (nl 4 el
Torsion e 5l oS o SIS |y Shear auss wo,S col, SIS b5 51 plaS ,o (55, 09b 0 )b

oS oo olus |, Ty & OT e Lapacity

Taorsic

Torsion Threshold Critical Conc.A
T. T, aT.. A
N-mm N-mm N-mm mm'

73649651.02 | 7230118.25 | 28920473 .01 20250

121
ENIVPRVN Nev



oo (rwiige sl By Gldls (b sleial,

) e 3 5 03,5 Gl lsazme | 5 03,8 )15 oa a8 o 51, ojle iy it o Mof o 5 Jlac) -
Assign>Frame>Properties Modifiers...

oS oo 8 a5 50 00l acwle Slaie 4y Tosional Constant ol 4 pladl

T & BTer o 03,5 (b s el | o3 lowme oo ool oy Dol 51 o woitins 2255 (> b -

loxguQﬁ.@Q.llﬁ.é)o05.;2';‘5@6&.’;‘;ISLLbjW‘mlggiio)‘i&gwwldfs';)y)a.mjsagto
53 S5 oL sl oI5

W (pl o 1oy (homn slas Koo Colae Ygoro b aeils (cdomy £5b U ogd (o0 ploxil Lo 4dS' (sl 393 0,
ol g5 BB lade s o5l

@y baid 358 gy 5 0Bl (o0 ) plp (cdamy Coli oo Wl ol g5 5l pdamy 45 (Sy50 50 Cenl 55510k @ p3Y
b 8 cl S ;MT Ol Jlo b by oo b yud 50 0550 ol 0,0 00,15 (gl yioms
JIs 2l >k 0
1398 (o0 el 5 20 4 Bly s (b sl o)) pias b 5l o Al e 0l s
SAFE ,s Jls >,k sl ETABS I 5,5 4 -
S5 S5 wlr g sildae lelas -
a8,lSe Shr sl g Py oslwl colas J s -
b layly i )l -
b s Jelos ol g el -
S (gl )adsbgs b J S -
SAFE ;s Jls (=)l 51y ETABS I >, a5 -)
JolS ¥ al> o s LRFS.EDB LG a1 05,0 )b a2yl aSl jl s o o oo F2K 25,5 -
(ol ool Judow L) 0 0 SAFE (gl (2,5 (58,5 & pladl 5 e el
File>Export> Story As SAFE V.12 F2K...

Select Load 4.5s s, SIS L R Sl {®) Export Floor Loads and Loads from Above ,

Select aSs 59, S L opl pogdle .ol suds Sl (5,135 L &Vl adS a5 (uiS o Jool> bl Cases...

Jol> sl 55 0l cy o5 L3 slo o5 j0 a5 Sl > (6,138, wluS 5 o bl 5l Load Combination
Swles 0,053 SLAB_Final.F2k lgie cox olgsds pus o 1) Jol> b ogles
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iy Options for Export to SAFE x {4y Select Load Cases to Export to SAFE » m\ Select Load Combos to Export to SAFE x
Story to Export Load Cases Load Combinations
Story Storyl ~

Loads to Export
O Export Foor Loads Only
@ Export Floor Loads and Loads from Above
(O Export Foor Loads plus Column and Wall Distortions

Load Cases and Load Combinations to Export

Select Load Cases. 13of 13 Cases Selected
Select Load Combinations... 24 of 57 Combos Selected

SAFE I Jlo u;"'er’ u>_'>|).|a 6‘)—.’ T ¥y s

Jis SAFE 4 il sVL il 5 () 2 3590 adeb ) (slog o 457 090 285 5 (g 235 S 2l (b sl

G pacw 3 50 50 Cewl ;3 4 p3Y all o yue (51300 g6 L 0 pdy Do JWl pl ST (gl cpl ogdle 05l

JEsl &y cesy) 90,5 b (&5 log,s gl haid |y o o lgs co il (gl o)) ptn 5| omd o 5 a5 S5 lo

M‘Qw)).vcb)b d)LJL.A)‘)SA.\.lJ LSLID :ULQ.) 61)4 ‘é.‘>|).lo (:5,....1).40013 u)l W‘Q)io.aui.\.lw 6‘ o)).l LSLQBJ""’

oS (oo o33 1, LB Cond 5l oo ags b 5 yuns | SAFE ailsyy jo0 SAFE ol 4 F2K L6 50,5 5,15 -
File > Import > SAFE .F2k File...

S5 gy anlol 51 LB g ol 0,53 5l ey 0uiS 0,053 olgsds sws ,o SLAB_Final.FDB ol a1, LB Slgs1,8 51 e

D9l S b lawg sl oy, sla,b JUsl coro uzmen § (6,105, Ol 5 g OVl las oy i conl i

255 planil e &g 4 Sl S 6l Wb s ol ik

S0y Sl g giladon Cledas sl Y

SAFE ,5 abolio ol saze ciyyo5 45 5Ls cas plowl ETABS jo lo o (gjludoe aSol @y a5 b o abldo iy poi | oo o
Ol a2l ol BB o b, sl a as g b ogd (oo dnogi aeliy (o Cu b ol S wis e il
s 3 Gl 9Bl ad o ol o Wil Aok 43S og Jab

Define >Beam Properties...

Jlé b 00,5 S 1, No Design 435 Modify/Show Properties... asSs g, S5 5 da 5 51 S0 e obsesl b

s (2o pldl a5l e (gt (6l 09
(Gl 03 s (F1,0) ETABS L ) o0y iy pa3 00,95 S 5 lpo o 5 (b5 Lael (53,65 S5 culpo Jlos]-

Db Jlosl la JIs gla ygiw o 5 a5 ol o cpl sl o3V cpl by 0sd sod Jiiie SAFE aaliy 4 Silogil & g0 4

Aol o 2l g Sl gl aid) I ol po Bllhe ol
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Sl 5 e yebaie pl s 0gd oo Jlesl lo sies lo S5 4y 0l jelaie « YO ply L S, S5 oo
(FY JS8) 058 (oo Jlosl abgy po i po ) e 51 (Bl 5 o5 slo o) I

Assign > Slab Data> Property Modifiers...

g oo Jlasl JloM1T, M22 o ailgs ) i ool

e

ﬂ Property/Stiffness Modification Factors

Property/Stiffness Modifiers for Analysis
Membrane f11 Direction
Membrane f22 Direction

Membrane 12 Direction

P

= =1=1r=1r=lr=r=1r—=1r—
P
| |
~a

Bending m11 Direction
Bending m22 Direction
Bending m12 Direction
Shear v13 Direction
Shear v23 Direction
Weight

Ok | | Cancel |

JIs s e 3ol FY IS

IRl Sln (Fabjloe SIS 23S S )8 09d (oo Jlesl (eSS g Dl L) (50,05 S5 ca s
sl curs Jloel jlon; (o o cnlio o en Jloel g Cens (03 sl Gl (59,65 S5 ulp2
LQ).».: «.)L?L».:‘ )‘ o Sl 00 ).E.._é).»o =9 Jlo G:Lw}«.o.b

Assign>Beam Data>Property Modifiers...

(FY JS8) 055 (oo Jlosl T jsmme Joo (omyial los alyo &1 oty

ﬂ Property/Stiffness Medification Factors x

Property/Stiffness Modffiers for Analysis
Cross-section (axial) Area
Shear Area in 2 direction
Shear Area in 3 direction
Torsional Constant
Moment of Inertia about 2 axis

Moment of Inertia about 3 axis 35

Slall=1=1=1=]1]=
)

Weight

ox

b 5 oa (S Mol FY S
e Sl (g QUG5 ey 5 e 4 5 b (g 9590 50

Assign>Column/Brace Data>Properties Modifiers...
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ﬁ Property/Stiffness Modification Factors =

Property/Stiffness Modffiers for Analysis
Crosssection (axial) Area
Shear Area in 2 direction
Shear Area in 3 direction
Torsional Constant
Moment of Inertia about 2 a:ds
Momert of Inertia about 3 axs

Weight

— =] =] — — — —
~ ~
b

OK | | Cancel |

-

s seas s Lol FE IS

wra [RUIPRCOW-Y 00)55 sSJ.J b)‘ybmk}déb r:lf).b om]t}osdqw)))mc\.}ybﬁ‘smf 6L®)|yé Syge 4o
(FO JSi) 00,5 oo Jlos! f11 addge a4 - Y0

Assign>Wall/Ramp Data>Properties Modifiers...

|

Property,/Stiffness Maodffiers for Analysis
Membrane f11 Direction
Membrane f22 Direction 35
Membrane f12 Direction
Bending m11 Direction
Bending m22 Direction
Bending m12 Direction
Shear w13 Direction
Shear v23 Direction

Weight

oK Cancel

Sgh oo bl Jae Jal i g asl ol Slagrle o azg5 b pdls [olS ol Lol g5 pkici =
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20.5.1.3.1 Nonprestressed cast-in-place concrete members
shall have specified concrete cover for reinforcement at least

that given in Table 20.5.1.3.1.

Table 20.5.1.3.1—Specified concrete cover for
cast-in-place nonprestressed concrete members

Specified
cover,
Concrete exposure Member Reinforcement mm
Cast against and
permanently in All All 75
contact with ground
No. 19 through 50
Exposed to weather No. 57 bars
or In contact with All No. 16 bar, MW200
ground or MD200 wire, and | 40
smaller
NWo. 43 and No. 57
40
Slabs, joists, bars
and walls
Not exposed to Wo. 36 bar and 20
- smaller
weather or in
contact with ground Beams, Primary
columns, reinforcement, 20
pedestals, and | stitrups, ties, spirals,
tension ties and hoops

B 11 JIs 1315 oI55 (oo sl a8 Y5 51 00 5, 8heo 0500 5 S ST b 0l31 slsp 5 pme po 15 4Kl &y agi b
w35 Design oo sl il 8,5 Jlai 55 e (hea Yo nln 1) o8 Cul Yo 0l 5o 10855 S5 5 e (L Yo il
(57 JS) oS o0 S5 ;0 VF 1) s g o Klie 0 pei oS o sl |, Design Preferences

] Design Preferences ? X

Code | Min. Cover Slabs | Min. Cover Beams  P/T Stress Check

MNon-Prestressed Reinforcement

Clear Cover Top {mm) a0

Clear Cover Bottom (mm) a0

Prefemed Bar Size 14 ~

Inner Slab Rebar Layer Layer B
Post-Tensioning

CGS of Tendon Top {mm) 25

CGS of Tendon for Bottom of Exterior Bay (mm) 40

CGS of Tendon for Bottom of Interior Bay {mm) 25
Minimum Reinforcing

Slab Type for Minimum Reinfarcing Two Way

| OK | | Cancel |

b o idg eedas F7 S
Al ged by gl colB PMlal 4 (g5l (oS sod (b 1) s Al 4y ax g

as § b o ol oy b Job jieS o3l VO 51 piieo bs e oIl Conl oo dogs Lo o oI filu> ki
3o Gk 5l Mol pl sl o sy yio 5lw FO L pl s ojlail cpl e Ve sgas ailes (5,8 L g Jle opl gl 045
(FY JS8) 058 0 pll Automatic Slab Mesh Option 45 5 Run
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B Automatic Slab Mesh Options ? *

Mesh Options

(@ Use Rectangular Mesh
Use Localized Meshing

Merge Points Where Possible
() None

Mesh Size
Approximate Maximum Mesh Size 0.65 m

Reset Defaults

oK Cancel

G e ojlasl Alal FY S

a5 S5 g oS 0 ol |, Advanced Modeling Option... 4535 Run ssie 3,0 51 cpl 5 ogdle

20 Plate - UZ, RX, RY On
(FA US8) 098 plodil (gom s O jgo 4 Judodi B4 yls (o0 0] o h‘ll

§#] Advanced Modeling Options ? .t

Active Degrees of Freedom
[ 2D Plate - UZ. BX. RY Only

Add Special Constraint

[] Add Rigid Diaphragm Constraint at Top of Columns and Walls Above

Vertical Offset Modeling

Ignore Vertical Offsets in Non PAT Models

OK | | Cancel

Sibdae slo a5 ple oulas FA JS2
A3,Ss G sl )les o b (g SLbL g (g ojlal colis J s Y

Gw)).:l.:wl.?ba UJ‘ OO b_talS 54.l.>).a L)"‘ ) W u.:L?u_w‘ 4h ).3‘).3 JLAJ‘ 6)4.\4 J&ud.'a.:Lo u,uL».u‘).v )49.1 L’>'>‘9J o)‘d.:‘
.)9...» uL?L..s‘fj.: ‘LSM")J)LQ d.]a.u‘ad;w‘uimﬁ(_g)i:é Q_?‘?" OB)LC \)9*.4‘50&5.»)).» QYLAJ‘JJLA)\) 43).]4&) U’“")"
D ploeil (61350 SLoS 5 pled gl b iy lo JyuS a5 Canl (S5 4 p3Y 0l dales adtie

alad 51 (5 485 o Coaglin ACH asbs ol llas 2353 oo plosl alo o 53 (o S5 (ol A i 25

YY (- .
: QSM <* ML?LO )

el odd gy w3 Vo ol s b do 15 5 Ceaglie e iuldl el i il o 32
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22.5.5.1 For nonprestressed members without axial force,
V. shall be calculated by:

v, =0.17A/fb,d (225.5.1)

s s oglie 1o Lo a5 e L oS 05 85 b g (ol Lt 5 o a5 abSs i S sl

V. = 0.17\/f .b,,d = 0.17 * 5 *

100 + 120
(—) (270) = 25.2KN - @V. = 19 KN/m

D98 oo S8 68,0 SlS 5 LSSy sl 295 V23 V13 ls adlge Jdos 5l ey

Display>Show Slab Forces/Stresses...

&
Load Case./Load Combination Component Type
(O Load Case (® Resultant Forces () Stresses Top Face
(@ Load Combination ShearEnvelope | | Max v () Stresses Midsurface () Stresses Bottom Face
Display Options Component
(®) Display Contours on Undeformed Shape Ol O M1 ® V13
(O) Display Contours on Deformed Shape QO F22 O m22 [@R"7x]
(C) Display Contours in Extruded Form O Fi12 (@R} () VMax
Sealing ) FMax ) MMax
) FMin ) MMin
O Fum

Contour Averaging at Nodes

O None
(® by Objects
(O by Selected Groups

Contour Range

Minimum kMs/m Apply Close
Manum v

2 >y Bl Glp b az 5 o a8 laSh Gy Jus TS

o G g (PPl e b (oo edlitul 0ad (08 gl (Al il @) 8,50 b J 5SSl gy !
g 18,5 L5 )5 g8 oS e 4l sl wuS el lone e 5 ad,laSy

il oS (oo bl abaly cul ) g8 (>l 093 aBylaSy B J5US sl epsd alo e o
ve = 0.17\f. = 0.17 5 = 0.85 MPa
Sl e (s o
v, < 0v,,0 =0.75 - Qv, = 0.64 MPa
oS oo U )5, Bl 5 51 s o sl e¥lasl 5l d alols o 1, s S13 6523 (gla ailgs ol 3l e

Display>Show Slab Forces/Stresses...
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8] Slab Forces/Stresses 7 X
Load Case/Load Combination Component Type
() Load Case (O Resultant Forces () Stresses Top Face
(@ Load Combination |5hearEnuebpe V| |Max V| ® Stresses Midsuface (O Stresses Bottom Face
Digplay Options Compenent
) Display Contours on Undeformed Shape [@R:3h] ® 513
(®) Display Cortours on Deformed Shape O 522 O s23
() Display Cortours in Extruded Form O 512 O sMaxv
Sealing O smax
®) Automatic O shin
() User Defined Scale Factor O svm Show Amows

Cortour Averaging at Nodes
) Mone
(® by Objects
O by Selected Groups Set Groups

Cortour Range

Minimum N/mmZ ‘ Ppply | | Close
— s Jwme

5 IS 45 o Sl P15 ] s w35 gl Sl g il pslie S G55 2 ol 3 oS (e 3

sk

i b 5 958 om ooliial g >les (sl oot almil golal Lo s8 S8 (gl daid Ceond (nl a8 el S3 4y p3Y
axgi b xS 90,5 pleol g L 1) g0 g Jgl al o ()55 (o0 090 (o0 plonil anlip Jasgd conlin (>)b loi Ll b az 5
Sl plril 1) poi (g J S s slog s polie 4

b sl s iy 5 F

JRlg aeSs 5l (P lals e 5 Sl (2L (50, l5 o -
Govb Wbl (b Jly 0 285 L 1o oz (i jemme S e S e b pln il wogd (oo 5L aS (5,5l 02y o
Ll b ng b cond (b slo)ls cnly ogdle il ools Bllad 098 (oo o lam &5 Slosr L aS 05 oo 5
LSS oy JoI ez 55 (b sla)le b oS (6975 a0 (o) 2 9590 S (loa b lime (LB 50) S0 o 5 ailSTa iy
dalst 5osle b ax 5 Sk lb)ly e &yganl 0 0,5 b Finite Elements ig, 40 1) po 15 as!
solazwl Replicate jsiws 4 (Draw >Draw Point) S bl oS 5 5l ol oo (b slo)lgs a5 (glpe (0

f‘)‘b <5L‘°)‘9-; P o)".\j‘ g = solawl =

o Slerian 25z 4 (b ey w5 (S gy (Il 0ed oo mum S iz la Y jo Liul) ya slalgs oS

10 g

oS blay SeS as Ll o b le dgl gy -

e5Y olaws s Relicate  jgiwo jloolatul b oo 5o ax 5 35 0 4y 35 0 alolb 4y >l)b)lei 1SS -

BB S0 Cl ) o Cond (nl slp e (ALl e 5 L gue 32 (g, 4 ng5 (A8 (S -
(595 ploxl 12
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Dbl ) 00,5 Sl 1) el sy 2 (b sla)lgi w5l g Pl sl 4 Ly o SloB oy -
< bl o &Y Gl 5 Select>Select>Properties>Select Design Strip Layers... s ;| 1L slalg

a5 (D
Design>Slab Design Overwrites>Strip Based...

el 00 Sl s 4 os Koo Slaseiie 45 05 oo o> liabl

] Strip Based Slab Design Overwrites ? X
General

Deszign This Strip
[ Ignere PT When Designing This Strip

Material
Rebar Materil 54 G30.18G:400 “|[2]
Cower

(® From Preferences

(O Specfiedta Center of Stesl
Top Cover

Battomn Cover

Live Load Reduction

Reduced Live Load Factor

0K | | Cancel |

b slaly Slelass OY S
Sy 3 00,5 Ol ) &S sldls oo [i] g, a0 Bl Olon Bl )
Design>Slab Design Overwrites>Finite Elements Based...

sl o Sl s 4 oo Koo Slaseie 45 05 oo Jol> liabl

B8 Finite Element Based Slab Design Overwrites ? s
Material
Rebar Material C5A-G3 186400 <[]
Cover

(® From Preferences

(O Specified to Center of Steel
Direction 1 - Top Cover

Direction 1 - Bottom Cover
Direction 2 - Top Cover

Direction 2 - Bottom Cover

Live Load Reduction
Reduced Live Load Factor

Design Option
Design This Slab Object
[ Ignare PT When Desigring This Slab Object

| 0K | | Cancel |
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Sgamme izl g, a4 b Slaglass OF IS
b 5 el anld plnil 0

S oS 5 oo [0 LSS s o ol j0 0,8 pladl ls ol g Lo 4 s Glg o0 358 slo a5l am Coles o

: yiand )‘ ‘) 4.0[.3).3 Ja.w}a AW ul.’?w‘ Lg)L‘)f)lg
Design>Design Combo...
bl oo (b g Jelox | o5l s oS g0 S

b i 5 S olsie &1, 42,5 458l 5, Shw Ll iy S 1 3,50 i (sl oo (oo gl alio e
390 dlg> Ol > g il o Koo les 1 o 4y, PBBlas o Shs 0iS o0

Table 8.6.1.1—A, i, for nenprestressed two-way

slabs
Reinforcement

hype i MFEa A, mm?
Deforraed bars =220 0.00204,
Deforraed bars M{
orwelded wita | =420 Crentar of: £, d
relnforcamert D004,

sl JBlos o Sl 4

0.6.1.2 A, min =hall be the greater of () and (b), except as
provided in 9.6.1.3. For a statically determinate beam with
a flange in tension, the value of b, shall be the lesser of &,

and 2b,_.
{a) _ﬂ.ZSJfE’"d
i
14
—bd
® 7.
:JBly JIs g, 6lp onlnlo
0.0018(400) mm?
Asminrop = ——5— (1000)(70) = 126 " - use $12@25 cm
iz sl sl
14 ( )
Agminpor = max] 25 (120)(270), 7222 (120)(270)| = 113 mm? - use 912

21y 698 Bl polae Jb (e oo VY +) el ol oolain] casVl jo S aiily oy Slas slasl oy iy
g Vb usii slas Sl 5 (OF JS) oS 0 0,15 Typical Uniform Reinforcing <. o >1,b zls axan
oS oo edilo g |y Liwly o 0l
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] 5lab Design 7 *
Choose Display Type Choose Strip Direction
Design Basis |Snip Bazed ~ | Layer A
Display Type | Enveloping Flexural Reinforcement | [ Layer B
[ Impose Minimum Reinforcing Layer Other
Rebar Location Shown Display Options
Show Top Rebar [ Fill Diagram
Show Bottom Rebar B Show Values at Controling Stations en Diagram
Reinforcing Display Type Show Rebar Above Specified Value
(O Show Rebar Intensity (Area/Unit Width) (O None
(O Show Total Rebar Area for Strip (® Typical Uniform Reinforcing Specified Below
(® Show Number of Bars of Size: (O Reinforcing Specified in Slab Rebar Objects
Bar Size Typical Uniform Reinforcing
Top 14 S (® Define by Bar Size and Bar Spacing
Bottom 14 ~ (O Define by Bar Area and Bar Spacing

Reinforcing Diagram Bar Size Spacing (mm)

[ Show Reinforcing Envelope Diagram Top 2 > 250
Bott
Scale Factor clll 12 | (650

Show Reinforcing Extent

| Apply | | Close |

Sloglas plo g mly 9 Yo Joo los M ol 9,5 5,15 OF U
Display>Show Slab Design...

MLQA})A)AJJ@?)A C.:L..: UJ‘ASAMSUSO el 00U ul.?b)‘ \'f ).J‘)J ‘5,..:5.1: 6LQQ)§L~4 oJ,o.S OHF J&w)o

el aml ol g YU Plas éj.il.:.a oS 0 oolatuwl agaze 132l g, 5l gl 6>|5j &l

0.0018(400) mm?

plonil 00 S5 illas Slonkats 5o 550 2o sl Khos alimle (glys 955 oo o3l 353 aml ly o YU o a8

- use P12@25 cm

Dy (s
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##] Slab Design ? s
Choose Display Type Reirforcing Direction and Location
Design Basis |Fmile Element Based v| (® Dirsction 1 - Top Rebar
Display Type |Em..e|°ping Flexural Reinforcement v| (O Direction 1 - Bottom Rebar

] Impose Minimum Reinforcing (O Direction 2 - Top Rebar

(O Direction 2 - Bottom Rebar
Contour Range

Minimum mm2/m Show Rebar Above Specied Value
- mom O e

(® Typical Unform Reinforcing Specified Below

Contour Averaging at Nodes
() Reinforcing Specied in Slab Rebar Objects

O Mone
@ by Objects Typical Unform Reinforcing
O by Selected Groups (® Define by Bar Size and Bar Spacing
(O) Define by Bar Area and Bar Spacing
Bar Size Spacing {mm)
Top 12 e ’250—‘
Bottom  [12 ~| [2s0 |
Rebar Averaging At Peaks
[ Average At Peaks
] Max. Averaging Width {m)

| Apply | | Close

Sgazee il (g) 4y o5 Connd )3 5L 9 90 (Lol Slos Kls osaline DO S5

3,5 )18 sy 9550 80 & Ll ,» Reinforcing Direction and Location cud jlas ol S35 4y 65V
Sr3e 3 dpdy Dygo ool cE Lo Sl ol jlade aul ccils b Jlasl piie los Ko ool &y L5 Logas
Sles osliial (b slajlys Gles 5l cenl gy <8l o 1) (he) Gl 4 jlisjse slod Se Jlade Culls )5 oS
o5 Bl Conl 2o ba)lgs nl (550 el S D jganl )3 09l SLRUl el ba Iy o0 wiled az s b SO
(BF JSB)ogd Sl Gl 9 (S sla)lys (S

Column strip £o/2 ﬁ_ YEx!erEor equivalent frame

One-half g l..—Edge
middle strip __FtH H‘“‘*—Cg_nterii?e
T o adjacen
=1 _T_ | ‘ pajnel
J ! ‘
—|—Ei|—-|— —
<1 (. 4
—{3—-:-—&;—-1- —H— : g
| | b
strip £,
Centerline —— Interior equivalent frame
of panel 4

25 >l o Ko sl Sl 5 Ssiw sloyls BF S

133
obe sagellae



oo (rwiige sl By Gldls (b sleial,

@l ala>dle sl e (o0 bl 93 |y b az 25 (3 o, SAFE ailiy lo az i oS o b gl alixdo -
) e I B az 5 (A p (b

Display>Show Slab Design...
s Choose Display Type s ,o Strip Based au ;5 a5 osS Jol> ylaebl oS (o 5L 1 Ul (>lb oy
!y b oS okl |, Shear Reinforcement a5 Display Type cod 5l .asb oo bl Design Basis

QY USs) 098 0ol ioles 3li 090 e )BSLO)T S LA 5,50 4

B8] slab Design ? ped
Choose Display Type Choose Strip Direction
Design Basis |Snip Based v| Layer A
Display Type | Shear Reinforcament v O Layer B
Layer Cther
Rebar Location Shown Display Options
Show Top Rebar [ Fill Diagram
| Show Bottom Rebar Show Values at Controlling Stations on Diagram
Reinforcing Digplay Type Show Rebar Above Specified Value
(®) Show Rebar Intensity (Area/Unit Length) (®) Mone
(") Show Total Rebar Area for Stip (7) Typical Unform Reirforcing Specified Below
() Show Mumber of Bars of Size: () Reinforeing Specified in Slab Rebar Objects
) Bar Size ) Typical Uniform Reinforcing
Top & ol (8) Define by Bar Size and Bar Spacing
Bottom 114 e () Define by Bar Area and Bar Spacing
Reinforcing Disgram ) Bar Size ~ Spacing {mm)
[ Show Reirfarcing Envelope Diagram 0 -
Scale Factor Botiom | =
Show Reinforcing Extent
| HApply | | Close

6‘1’)'«’ C)'b @L».: odaliw QY J&u

Ladd Coond (pl aS 0ad G805 090 duslie b a5 Dgels 6l u=_3.1):.>\ Slojz 5o oads el o, SKhe b sl ol oyl
)é o 00 L)"AL’ Le‘.;‘ wl?bal)..\.woé‘d A_Jl?LA.»O 5; &Lb.o).vy 6& Comnd L‘;"J)J C}uosl.s.osu))b Q).’)lsd?).».: ‘5‘)4
39 oo dmogs Jloenl b (W 2 0.50V0) ol 53 3550 (80 5 Koo s 4z 15 51 (g3l (sl Lo oV sy

g oolainl b az 5 plod ;o w3 alal) Billae obp Sgels J8las o)lgen

Table 9.6.3.3—Required A,

Beam type Ay il
’ bw
MNonprestressed O_OGQ,JZ— (a)
and prestressed ) ®
with 4,.£, < Greater of: N
0.4 dyfyy + AF) o_ssf—“’ o)
M
T
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it $103,Sn Coral @y 55 b (S bI) SVT omo yo lo3, s il 5 S T35 il ool -
a I a5 G0l 50 LS |y s 4l (slos Shoo Sublo ) b iy sl oS 3l gy o JUi 4>
g,y bt lds Jolie ais (o) a4 mM1L, M22) bes ool 5l s 0 oo LS5 GiaS b 0 ) D) ozl o
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a5 &dlse )0 @l Ghp IS sk 40yl mae sl Cadge pan 50 il J5SS 6l ale cudgae SAFE I3
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(25 19 Gorm 02 9 285 (195 50 08) Do 4 25 b Jlasl -
Sl sl adsS (g o lgs 4 Jlo Jlail -
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2S¢ o 0,33 SAFE_Final_Punch.FDB lsic cov jsSde Ll o)l T L Salés g 0gd (oo oolaul Jlo iwes
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opl ,e sl e (Edit>Edit Lines> Convert Beams to Slab Areas 4l .5 Clil) o @ o5 fas 50

Olebl C )0 hgy el crlplo 9 abl (oo 0al o 5 Cwls plp s Culks JS 0iS (o (28 aslip by,

Sgalgm OA S Gillas b il o o) yoanno INONE & ahain jois 5 Jsl L, 5l ooliinl & jg0 j0 il oo

Assign > Beam Data>Beam Properties>None
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Hote: Openings shown are located within
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Fig. R22.6. 4 3—Effect of openings and fFee edges (gffective

perimetar shown with dashed Iinas).
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Define Mass Source Using Load Pattems

Load Pattem Scale Factor
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lgnore Lateral Mass
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18.12.9.1 ¥V, of diaphragms shall not exceed:

V,= A, 01TMJF+p.f.) (18.12.9.1)
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12.5.3.4 For a diaphragm that is enfirely cast-in-place,

cross-sectional dimensions shall be selected to satisfy Eq.
(12.5.3.4).

¥, <0.6604,, /1 (12.5.3.4)

where the value of .ff used to calculate ¥; shall not
exceed 8.3 MPa.
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v, = @ X min (0.17\/25 +0.0018(400), 0.66 ’f’c> = 1.18 MPa

adlga jloslinl b (oled NS ,b SlS 5 pled sl 99290 (Sbp G5yl 2ilmo SAL b 092ge (il (AT duglio -
5ol 2l 6135,k Sl 5 ples 5l g Ll aS 5 Ol (oo SRS Sdape ln e h (o0 analie Ty ke L ST12
o Koo (50,5 4ol & (65l Spi a9 WAL (o0 Sl J S ol Bolg (slells o Vgae ols plnil | abogn e ]S
(7 JS8) il (o0 azmio 215 (5

] so Gy o alaly 51 5Ls 0 50 0, Khie S LBy (5,1088 Ko 45 5L &y 40 -

W\ _ ;

da.sod..i) ML?LA J)ﬂm UJ‘ ol oée.usi.?uulaJJd.uJ;JdSw‘ J\o)l 6‘ 00gdta 4o u“")"VLL 5053 d.]a.t‘) )045
(o2 S50 aSLD 90 5 JSiie 4Y S O jg0 4y) 058 0 48LS] 39250 siem (sl Ko

255 BT L5 55 iy sl 03 ) sl e sbiel (5 25 (sl e Al e a5l b o B e o513k Ll 8 %

145
obe sagellae



oo (rwiige sl By Gldls (b sleial,

5 @ ®)

8] slab Forces/Stresses 7 x

v "
Load Case/Load Combination Component Type |l Il
O Load Case O Resuitant Forces O Strosses Top Face v "

® Load Combination | ShearEnvelope < [wax_~] ® Stresses Miduface (O Siresses Bottom Face T @
@

Display Options Component
@® Display Contours on Undeformed Shape O sn O si3 [ -
O Dispay Cortours on Deformed Shape Os2 OB
O Display Cortours in Extnuded Form @512 O SMaxy
Scaling O SMax | 00
O Automatic G sMin ! | /_
O UserDefined  Scale Factor O s [ Show Amows HER. | 2 S @

Corttour Averaging &t Nodes

O MNone )
@ by Objects ‘ \
O by Selected Groups [ Set Groups.. | |
i
Cortour Range ! |
\ —— 1]
|

5 | | 7,@

o Ir—
>

5188 Ao (y5,0 b S £F S
(JEsl o) SKhol by slos S 75k g J 08 =Y

ool alas o131 oy BY S5 55 o8 50 55 J o slye e e 51 030 sl i 42 JI5 JLa v o

| 0

S Gy

S Gy

Sl i J S wolae g jles 4 s Jlasl £V IS

146
ENIVPRVN Nev



oo (rwiige sl By Gldls (b sleial,

Viose sln 035 (o0 0ol (230 )l (s350e lod Shee Bk 5l a2l 05 550 9y JUESI 20 Y 5) @2le o
298 0 s dlansly o JE o0 ) 05 (o0 513 (s p 3590 bl j0 a5 358 o plonil JUT S 5SS
g oo LSl JIo 39250 (slod Ko 4y 0 Ko ] 09l g0 Joo ool ools ol

109 oo dmle aol ol YYAFY ui Gile SKhol iy

22.9.4.2 If shear-friction reinforcement is perpendicular to
the shear plane, nominal shear strength across the assumed
shear plane shall be calculated by:

V= 1Ay, (22.9.4.2)

where A, is the area of reinforcement crossing the assumed
shear plane to resist shear, and p is the coefficient of friction
in accordance with Table 22.9.4.2.

Table 22.9.4.2—Coefficients of friction

Coefficient of
Contact surface condition friction p

Concrete placed monolithically 140 (a)

Concrete placed against hardened concrete
that is clean, free of laitance, and intentionally
roughened to a full amplitude of approximately
6 mm

1.00 ()

Concrete placed agamst hardened conerete that
1s clean, free of laitance, and not mtentionally 0.6L (c)
roughened

Concrete placed against as-rolled structural
steel that 15 clean, free of paint, and with shear
transferred across the contact surface by headed
studs or by welded deformed bars or wires.

0.7h @

(U = 1.0 for normalweight concrete. For lightweight concrete, ). is calculated as given
in 19.2 4, but shall not exceed 0.85.
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40000 = 0.75 * 1.4 * 400 * A,y — A,y = 0.95 cm?/m
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18.12.3.2 Elements of a structural diaphragm system that
are subjected primarily to axial forces and used to transfer
diaphragm shear or flexural forces around openings or other
discontinuities shall satisfy the requirements for collectors
in 18.12.7.6 and 18.12.7.7.
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Table 18.12.7.6—Transverse reinforcement for
collector elements

Transverse
reinforcement Applicable expressions
iy '
A/sh, for rectilinear 0.09 rA @
hoop ’ T 2
A r
0_45[—*’—1]£ )
. Aa ) fn
p; for spiral or Greater
circular hoop of: P
0125 (©
b4

plol o9 (5,108 Cgals LS g0 10 b 0gd o awslie 0.2f7 L Envelope L oS5 sl S11,522 o adlge
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Table 18.12.7.6—Transverse reinforcement for
collector elements

Transverse
reinforcement Applicable expressions
iy '
A/sh, for rectilinear 0.09 rA @
hoop . T 2
A r
045 [—g— 1]£ )
. Aa ) fn
p; for spiral or Greater
circular hoop of: P
0.12=% (©
b4
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